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R is For All = Part 1: R Commander
Alongside R Swirl, R Commander as ‘Quick Start’: a

code-generating Graphical User Interface to serve as

‘sateway’ to sooner use of R in your Data Analyses

Emily Leary & Ken Wilkins
2025-07-31

NIDDK Biostats Seminar Series

Please note: if any PDF hyperlinks within a multi-layered slide series appear not to work, please browse to _final_ (full) slides in that series to use the hyperlinks


https://www.niddk.nih.gov/news/meetings-workshops/2025/r-is-for-all
https://bioinformatics.ccr.cancer.gov/btep/?s=niddk
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Learning Objectives: \_ B L\
Be able to identify, load, & use R resources/packages based upon needs & o
experience level with R.

1. For beginners, know how to load R Commander, import data, and
navigate the GUI.
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National Institute of
m Diabetes and Digestive
and Kidney Diseases
ing Objectives:
Be able to identify, load, & use R resources/packages based upon needs &
experience level with R.
1. For beginners, know how to load R Commander, import data, and

navigate the GUI. NOTE: we only provide a ‘whistlestop’/‘whirlwind’ tour — seek
other introductions for a fuller picture!

2, For those interested in learning more about coding/functions, how to use R Swirl to learn
Joundations jor junctions and coding nigner level operations (loops, combining junctions, and

oullding new functions).

Other helpful
resources /

3. For regular users of R, now to use tidyverse jor data manipulation, organization, and  semiars
witnin ’

oreparation for analysis.

4, For those using R jor researcn worik, now to utilize R Markdown jfor appropriate ancd ..-*.-l :

rnoroucn broject clocumentation anc meanacgement,
J


https://bioinformatics.ccr.cancer.gov/btep/classes/niddk-biostats-seminar-series-

R Commander: a less-steep learning curve for R,
distinct interface from the widely-known [ELSI

R Commander or ‘Rcmdr’

R R Commander

Things to Consider
File Edit Data Statistics Graphs Models Distributions

R Data set: | || <No active dataset:{ /” Edit data set

Nature Programming language ‘Low-code’” entry way into R Workflow Development

Usage Statistical computing, analysis Enhancing use of R through menu-driven use, plugins

User Interface Command-line
Functionality Core statistical analysis & graphing Code generation per menu-chosen steps, customizable

GUI with additional plugins to implement extensions

R RGU
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publicarions.

YEARS

This is where (in Rgui)
everything is viewed |




R Commander: a less-steep learning curve for R,
distinct interface from the widely-known

R Commander or ‘Rcmdr’

Things to Consider Lo BRI S

File Edit Data Statistics Graphs Models Distributions

R Data set:

<MNo active dataset> _" Edit data set

Nature Programming language ‘Low-code’ entry way into R Workflow Development

Usage Statistical computing, analysis Enhancing use of R through menu-driven use, plugins

User Interface Command-line

GUI with additional plugins to implement extensions

Functionality Core statistical analysis & graphing Code generation per menu-chosen steps, customizable

RRGu R Commander

File Edit View Misc Packages Windows Help it Om Stio Goph Modes Dobutors Tooh Hep
Ry el e

R Console E==[E=n~"

[E=m (e~

This becomes
~~~~~ where (in Remdr) -~

Th|s |srwhere (|n Rgui)
everything is viewed

Thls remams “behind
the scenes” of Rcmdr
TILL you need a GRAPH!

everything gets
done
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and Kidney Diseases

Ris For All, Part 1: R Commander to lower learning curves, via:

¢ Loading Rcmdr, Orientation to its GUlI Window’s panels/menus

e Importing Data, setting an Active Dataset, single dataset exploration

e Navigating menus & generating re-usable code: exploring Active data
e Take Home Objective: For beginners, know how to load R

Commander, import data, and navigate the GUI.

NIDDK Biostats Seminar Series Speaker
Today, 2025-07-31

Ken Wilkins: Mathematical Statistician, Biostatistics Program Office
Office of the Director, NIDDK



https://bioinformatics.ccr.cancer.gov/btep/classes/principles-of-data-collection-and-management
https://bioinformatics.ccr.cancer.gov/btep/classes/principles-of-data-collection-and-management
https://bioinformatics.ccr.cancer.gov/btep/classes/principles-of-data-collection-and-management

R Commander: online resources to get started

NB: NOT a hands-on session, only ‘try as you listen’ later in webinar

* Qutside-of-webinar resources for getting started on yr own




R Commander: online resources to get started

NB: NOT a hands-on session, only ‘try as you listen’ later in webinar

* Qutside-of-webinar resources for getting started on yr own

* Ones on ‘working within Rstudio”: these date from an era when you wouldn’t get below \ error

* Under 10 minutes: An Introduction to R Commander (Remdr): Basic Statistics GUI for R — YouTube
e Under 1 hour: (also R GUI) https://www.youtube.com/watch?v=7A0VPxwjh3w
 OTHERS to be shared under our NIH-wide-accessible SharePoint folder

.ﬂ\“"’ R Session Aborted

R encountered a {atal error.

The session was terminated.

Start New Session




R Commander: online resources to get started

NB: NOT a hands-on session, only ‘try as you listen’ later in webinar

Outside-of-webinar resources for getting started on yr own

Ones on ‘working within Rstudio”: these date from an era when you wouldn’t get below \ error

\

e Under 10 minutes: An Introduction to R Commander (Rcmdr): Basic Statistics GUI for R — YouTube
* Under 1 hour: (also R GUI) https://www.youtube.com/watch?v=7A0VPxwih3w
* OTHERS to be shared under our NIH-wide-accessible SharePoint folder

Working within“R GUI alone for our current session: sidestep issues%‘\' R Session Aborted

R encountered a fatal error.

* Installation will depend on your operating system(s):
* Windows — use Single Document Interface (SDI) option for best ‘behavior’
* Mac —some care needed with regard to the Graphical-display device
* Linux/Unix — may be rare, yet the “R Commander GU!” should work as well ,l

Why ‘jump through hoops’ just to install a running version?
e PAYS OFF by the TIME SAVED on getting started importing & viewing data
* REAPS BIGGER DIVIDENDS as you can quickly explore data AND save associated code: REPRODUCIBILTY
How R Commander provides a less-steep learning curve: helps facilitate data analysis overall. m) ZS

NIDDK

ession was terminated.



https://www.youtube.com/watch?v=1k6uYhNuYs4
https://www.youtube.com/watch?v=7A0VPxwjh3w

 Set CRAN mirror, then

R RGui
File Edit View Misc

|ES|EP|GB||QQIIQ|1

‘R RConsole

R version ¢4.4.0
Copyright (C) 20:I
Platform: x86_64-

Type ‘license()’

d4

Type 'contributoxs()'

Packages Windows Help

Load package...

Set CRAN mirror..,
Select repositories...
Install package(s)...
Update packages...

Install package(s) from local files...

R is free software and comes with ABSOLUTELY NO WARRANTY,
You are welcome to redistribute it under ceértain condicions.
‘licence()' for distribution

R 1s a collaborative project with many contributors.
for more information and
‘citation()' on how to cite R or R packages in publications.

Computin

details.

Natural language support but running in an English locale

Type ‘demo()* for some demos, ‘help()' for on-line help, or
*help.starc()' for an HIML browser intexface to help.

After starting the R Graphical User Interface (GUI), see Packages

'Secme CRAN marrors

Germany (Gottangen) (hetps)
Germanry (Lepaig) [hitps)
Germany (Manstes) [Netps)
Greece [httpz)

Hungary [htips]

Icetand [https)

India (Bengaluru} | tps]
Indu (Bhubaneswar) {hitps)
Indonaas (Banda Aceh) [https]
Raly (Vidano) [htps]

haly (Padua) [tttps)

Japen (Yonezswa) (Mttps)
Kores (Gyeongrar#) | Wt ps)
Mexco {Mexico City) [brtps)
Moo (Texcoco) [Meps)
Moro<co [Mtps)
Nethesiands (Oronten) [hetps)
New Zesland [Mtrps)
Norway [Mtps)

Poland [Mtps]

South Afnca (Johannesburg) [eeps]
Spain (A Conala) (hetps)
Spain (Madnd) (Mitps)
Sweden (Umal) (Meps)
Switzestand Zunch 1) [hitps]
Tawwan (Tepel) Retps)
Turkey Deni) [Hitps)

UK (Bristol) [Meps)

UK (Landon 1) (hetps)

USA (A} [Mtps]

USA (M) [Mttps)

USA (MO) {1 ttps]

USA (OH) (Mtps)

USA (OR) [hetps)

USA (IN) [meps]

UsA (UT) [mttpz]

Unted Asab Emuates [mtps!
Urugriay [hetps)

[othes merors]

oK Cancel

=

..install ‘Remdr’: select menu ‘Packages > Install...”
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R is free software and comes with ASSOLUTELY NO WARRANTY. i Phagn dopeiToch dovzlosded 1.6 3O
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< =y ** using staged installaticn
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R
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:"‘49"’?"“#“‘3 ** byte-compile and prepare package for lazy loading
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R 13 a collaborative project with many contributors. r.mo:z:wu.m
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After starting the R G
* Set CRAN mirror, th

raphical User Interface (GUI), see Packages

en

R RGui
File Edit View Misc

|ES|EP|GB||QQ Ialf

‘R RConsole

R veérsion ¢.4£.0
Copyright (C) 202
Platform: x86_64-

Type ‘license()’

d4

or

Type 'contributoxs()'

Packages Windows Help
Load package...

Set CRAN mirror..,
Select repositories...
Install package(s)...
Update packages...

Install package(s) from local files...

R is free software and comes with ABSOLUTELY NO WARRANTY,
You are welcome to redistribute it under ceértain condicions.
‘licence()' for distribution

R 1s a collaborative project with many contributors.
for more information and
'‘citation()' on how to cite R or R packages in publications.

Type ‘demo()* for some demos, ‘help()' for
*help.starc()' for an HIML browser intexface to help.

Computin

details.

Natuxal language support but running in an English locale

on-line help, ox

* Use ‘Packages > Load Package...’ OR Enter “library(Rcmdr)”

'Secme CRAN marrors

Germany (Gottangen) (hetps)
Germany (Legpaig) [hetps)
Germany (Manstes) [Netps)
Greece [httpz)

Hungary [heips]

Icetand [https)

India (Bengaluru} | Mtps]
Indha (Bhubaneswar) {https)

Raly (Vidano) [htps]

faly (Padua) [tttps)

Japen (Yonezswa) (Mttps)
Kores (Gyeongrar#) | Wtps)
Mexco {Mexico City) [brrps)
Moo (Texcoco) [Meps)
Moro<co [Mtps)
Netherlands (Ovonten) [hetps)
New Zealand (https)

Norway [Mtps)

Poland [Mtps]

Spain (A Conala) (hetps)
Spain (Madnd) (Mitps)
Sweden (Umal) (Meps)
Switzestand Zunch 1) [hitps]
Taowan (Tospei) (Retps)
Turkey Deni) [Hitps)
UK (Bristol) [Meps)

UK (Landon 1) (hetps)
USA (A} [Mtps]

USA (M) [Mttps)

USA (MO) {1 1ttps]

USA (OH) (Mtps)

USA (OR) [hetps]

USA (IN) [meps]

UsA (UT) [mttpz]

Unted Asab Emuates [mtps!
Urugriay [hetps)

[othes merors]

Indonaas (Banda Aceh) [https]

South Afncas (JoNannesburg) [eeps)

oK

Cancel

Q@ RGui

File €dt View Misc Packages Viindows Help
Load package...
[ .| Set CRAN mircor...

R R Console - S
Select repositories...

Install package(s)...

R version 4.4.0
Update packages...

Copyzight (C) 20:
cformw: <

EIacEoE B =2cd Install package(s) from local files...

R is free software and comes with A3SOLUTELY NO WARRANIY.

You are welcome to redistribute 1t under certain conditions.

Type 'license()’' or 'licence()' for distribution details.

Natural language support but ruanlng i1n an English locale
R 13 a collaborative project with many contributors.
Type 'contributors()' for more information and
'‘citation()' on how TO cite R or R packages in publications.
Type ‘'demo()*® for some demos, ‘'help()’ for on-line help, oI

'help.start()®' for an KIML browser interface to help.
Type 'q()' To quit R.

4
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After starting the R G
* Set CRAN mirror, th

en

R RGui
File Edit View Misc Packages Windows Help
|D" EIQ”[’@ Bla Load package...
i Set CRAN micror...

‘R RConsole o
Select repositories...

Install package(s)...
R veérsion ¢.4.0
Copyright (C) 20:I
Placform: x86_64%-

Update packages... Computin:

Install package(s) from local files...

R is free software and comes with ABSOLUTELY NO WARRANTY.
You are welcome to redistribute it under certain condicions.
Type ‘license()' or 'licence()' for distribution details.

Natuxal language support but running in an English locale

R 13 a collaborative project with many contributors.
Type 'contributors()' for more information and
'‘citation()' on how to cite R or R packages in publications.

Type ‘dema()* for some demos, ‘help()' for on=-line help, or
*help.staxc()' for an HIML browser intexface to help.

d4

* Use ‘Packages > Load Paékage...’ OR Enter “librar
* Given a few moments’ time, Remdr GUI wi

'Secme CRAN marrors

Germany (Gottngen) (https)
Germany (Legpaig) [https)
Grrmany (Manstes) [Metps)
Geeece [hetpz]

Hungary [heips]

Ietand [https)

India (Bengaluru} |Iittps)
Inds (Bhubaneswar) {https]

Maly Vdano) [hetps]

ltaly (Padua) [bttps)

Rpan (Yoneswa) [Meps]
Kores (Gyeonguers) | hitps |
Meco {Mexico City) [deps)
Moo (Texcoco) [Meps]
Moro<co [Mtps)

New Zeasland [t1ps)
Norway [https)
Poland [Mtps]

Spain (A Conuta) (Wtps)
Spain (Madnd) (hetps)
Sweden (Umal) (Meps]
Switzerand Zunch 1) [htps]
Taewan (Topei) [(eaps)
Tuikey (Denisth) [htps)
UK (Bristol) [Megs]

UK (Landon 1) (hetps)
USA (A} [Mtps]

USA (M) [ntips]

USA (MO) (hitps]

USA (OH) (Mtps)

USA (OR) [Feeps]

USA (IN) [tps]

Usa (UT) [ateps]

Unsted Asab Emuates [mtps|
Uruguay [hetps)

[othes menroes]

Indoneas (Banda Aceh) [https]

Netherlands (Oronten) [https)

South Afrca (loRannesburg) (Metps]

oK

Cancel

=

raphical User Interface (GUI), see Packages

..install ‘Remdr’: select menu ‘Packages > Install...”

R RGui
File &dit View Misc Packages Vindows Help

EECIRLE

=

Load package...

Set CRAN mirtor...

R R Console - v
Select repositories...

Install package(s)...
R version 4.4.0
Copyzight (C) 20:
Placform: xX8&_64-

Update packages... Computing

Install package(s) from local files...

R is free software and comes with A3SOLUTELY NO WARRANTY.
You are welcome to redistribute it under certain conditions.

Type 'license()’ or 'licence()' for distribution details.
Nactural language support but runnlng 1n an English locale

R 13 a collaborative project with many contributors.

Type 'contributors()' for more information and

‘citation ()’ on how to cite R or R packages in publications.

Type ‘'demo()*® for some demos, ‘'help()' for on-line help, oI

'help.start()' for an HIML browser interface to help.
Type 'q()' to quit R.
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How to start R Commander: install & load ‘Rcmdr

After starting the R Graphical User Interface (GUI), see Packages

* Set CRAN mirror,

then

R RGui

File Edit

View  Misc

[

Packages Windows Help

Load package...

Set CRAN mirror...

"R R Console

Select repositories...
Install package(s)...
R version 4.4.0
Copyright () 20: Update packages...
Platform: x86_64-

Computing

Install package(s) from local files...

R is free software and comes with ABSOLUTELY NO WARRANTY.
You are welcome to redistribute it under certain conditions.
Type 'license()' or '"licence()' for distribution details.
Natural language support but running in an English locale

R is a collaborative project with many contributors.
Type 'contributors()' for more information and
'citation()' on how to cite R or R packages in publications.

Type 'demo()' for some demos, 'help()' for on-line help, or
'help.start ()" for an HTML browser interface to help.

* Use ‘Packages > Load Packége...’ OR Enter “library(Rcmc
* Given a few moments’ time, Remdr GUI will ‘pop up’

* ‘originating’ R GUI window will stay “in the background”:......--

-
Secure CRAN mirrors

Germany (Géttingen) [https]

Germany (Leipzig) [https]

Germany (Manster) [https]

Greece [https]

Hungary [https]

Iceland [https]

India (Bengaluru) [https]

India (Bhubaneswar) [https]

Indonesia (Banda Aceh) [https]

Italy (Milano) [https)

Italy (Padua) [https]

Japan (Yonezawa) [https]

Korea (Gyeongsan-si) [https]

Mexico (Mexico City) [https]
lexico (Texcoco) [hitps]

Morocco [https]

INetherlands (Dronten) [https]

New Zealand [https]

Norway [https]

Poland [https]

South Africa (Johannesburg) [https]

Spain (A Corufia) [https]

Spain (Madrid) [https]

Sweden (Umes) [https]

Switzerland (Zurich 1) [https]

Taiwan (Taipei) [https]

Turkey (Denizli) [https]

UK (Bristol) [https]

UK (London 1) [https]

USA (14) [https]

USA (OR) [https]

USA (TN) [https]

USA (UT) [https]

United Arab Emirates [https]
Uruguay [https]

(other mirrors)

oK Cancel

<

..install ‘Remdr’: select menu ‘Packages > Install...’

R RGui
File Edit View Misc

EIBEE

R R Console

Packages Windows Help

Load package...

Set CRAN mirror...
Select repositories...

Install package(s)...
R version 4.4.0
Copyright (C) 20:
Platform: x86_64-

Update packages... e caputing

Install package(s) from local files...

R is free software and comes with ABSOLUTELY NC WARRANTY.
You are welcome to redistribute it under certain conditions.
Type 'license()"' or 'licence()' for distribution details.

Natural language support but running in an English locale

R is a collaborative project with many contributors.
Type 'contributors()' for more information and
'citation()' on how to cite R or R packages in publications.

Type 'demo()' for some demos, 'help()' for on-line help, or
'help.start()' for an HTML browser interface to help.
Type 'g()" to gquit R.

R RGUi (64-bit)
Packages File Edit View Misc Packages Windows Help
rciplot
RCircos
rcites R R Console
RCLabels
RClickhouse e tall
RClimacell ~--- Please select a CRAN mirror for use in this session ---
rclipboard
A
emdcheck There is a y version available but the source version is later:
eds_compilati
RemdrMlisc Fi

Remdr FALSE
RemdrPlugin.aRnova

RemdiPlugin BWS1
RemdrPlugin BWS2
RemdiPlugin BWS3
RemdrPlugin.cpd
RemdiPlugin DCCY
RemdrPlugin DCE
RemdiPlugin. depth Tools
RemdrPlugin DoE
RemdrPlugin EACSPIR * installing *s
;U“:';:uw EEM ** package 'Rcm
RemcrPlogin Eeport using staged i
RemdrPlugin. FactoMineR R

RemdrPlugin HH inst

RemdrPlugin KMggplot2 byte-compile and prepare package for lazy loading
RemdrPluginMA

RemdiPlugin MPAStats
RemdrPlugin, NMBU
RemdiPlugin.orloca

installing the source package ‘Rcmdr’

tps://1ib.stat.cmu.edu/R/CRAN/src/c:
'application/x-gzip' length 7992226 bytes (7.6 MB)

L
acked and MDS sums checked

ntrib/Remdr_2.9-5.tar.gz’

RemarPlugin PeaRobust
RemdrPlugin RiskDemo
RemrPlugin. RMTClags
RemdrPlugin ROC
RemarPlugin.sos
RemdPlugin.survival
RemarPlugin TeachingDemos
RemrPlugin.Teachstat

: package 'effects' was built under ersion 4.2.1
* DONE (Recmdr)

The

ocaded source packages are in
\Users\wil! k3\AppData\Local\Temp\RtmpQbxdZD\dow:

oK Cancel

R v
** testing if installed package keeps a record of temporary installation path

oaded_packages

r)” at ll>”

R R Commancer
Fle Gt Oata Sttiticc Gaphe Model Disrbutons Tooks Help
R Ovsser <oscivedmmens|  /Ednanaser [0 Viewdstoet  Moder | X <he actue mdes

RSt RMarkdown

This remains “behind
the scenes” of Remdr;
TILL you need a GRAPH!

The folloing object is masked from ‘packageibase’

ouput

2 subr



Things to note in R Commander: menus / panels

Menu follows that of many cross-platform applications” GUIs
* File / Edit/ .../ Help

“...” = Application-specific menus:

* ‘Data’ / ‘Statistics’ / ‘Graphs’ / ‘Models’ / ‘Distributions’ / ‘Tools’

* ...the menu names are intuitive to invite you to browse for what you want!
* “Ribbon” below the File/Edit/&c. is effectively a ‘mini-dashboard’

* To immediate right of ‘R’ logo: “active” Data set name in red (OR ‘no active’)

* In between Data Set indicator & Model indicator: buttons to edit/view data
* To far right of ‘R” logo: “active” Model name in red (OR ‘no active’)

- (R R Comman der — a X

| File Edit Data Statistics Graphs Models Distributions Tools Help

_Q Data set: <No active dataset> / Edit data set View data set  Model: | £ <No active model




Things to note in R Commander: menus / panels

Menu follows that of many cross-platform applications’” GUIs
- File / Edit / ... / Help

« “..” = Application-specific menus:

 ‘Data’ / ‘Statistics’ / ‘Graphs’ / ‘Models’ / ‘Distributions’ / ‘Tools’

* ...the menu names are intuitive to invite you to browse for what you want!
* “Ribbon” below the File/Edit/&c. is effectively a ‘mini-dashboard’

* To immediate right of ‘R’ logo: “active” Data set name in red (OR ‘no active’)

* In between Data Set indicator & Model indicator: buttons to edit/view data

. . . If in BLUE can provide data options
* To far right of ‘R” logo: “active” Model name inred . . 40 diag:ostics’ o

| “R' R Comman der — O X | Resmswries :
| File Edit Data Statistics Graphs Models Distributions Tools Help 3
|

nnnnnnnnnnnnnnnnnn

| R‘ Data set: <No active dataset> .__' Edit data set | View data set Model: | £ <MNo active model> ‘

eeeeeeeeeeeeeeeeeeeeeeeeeeeeeee

File Edit Data Statistics Graphs Models Distributions  Tools  Help

Rl Data set: syntheticFacterial Trial /_’Editdataset |E) View dataset  Model: | £ RegModel.1



Loading, Orientation to Rcmdr GUI’s panels/menus

* After menu-load OR entering below in R GUI’s ‘console’ prompt see:

> library (Rcmdr)

mmmmmmmmmm

We will next break down these panels @ =« <o oo i i

R Script R Markdown

' R Script R Markdown < Note distinct tabs™ in top panel
I

Output

* For now, we stick to Script tab in top panel; R Markdown covered later

Messages

(3] NOTE: Hello wilkinskj )
essages
(4] WARNING: The Windows version of the R Commander works best under r——m:mnouumﬂj-
ARNING: The Windows version of the R C der works best under
RGul Wlth the Squ'le documeqt lnterface (SDI) See ‘)CommandeY RGux with the single-document 1nterface (SDI): see 2Commander.




Loading, Orientation to Rcmdr GUI’s panels/menus

* After menu-load OR entering below in R GUI’s ‘console’ prompt see:
> library (Rcmdr)

RR
o File Edit Data Statistics Graphs els Distributions Tools Help
We will next break down these panels &= oo oo v

R Script R Markdown < Note distinct tabs™ in top panel

Ot {% Submit

Output

* For now, we stick to Script tab in top panel; R Markdown covered later
Messages

(3) NOTE: Hello wilkinskj .
essages

(4] WARNING: The Windows version of the R Commander works best under |5y weiio witkins
ARNING: The Windows ersion of cthe R Commander works best under
RGui with the single-document interface (SDI); see ?Commander. leumtm,mubmcxm1m“h“ o o A s




Loading, Orientation to Rcmdr GUI’s panels/menus

* After menu-load OR entering below in R GUI’s ‘console’ prompt see:
> library (Rcmdr)

& R Commander - a X
. File Edit Data Statistics Graphs Models Distnbutions Tools Heip
We Wl I | n ext b re a k d OW n t h ese p a n e I S R Dataset | | <No active dataset> Edit data set | Viewdataset  Model: | I <No actve modet>
RScnpt R Markdown
R Script R Markdown < Note distinct tabs™ in top panel
'*Submn
Output
* For now, we stick to Script tab in top panel; R Markdown covered later
Messages
'[3] NOTE: Hello wilkinsk] "
[4] WARNING: The Windows version of the R Commander works best under :m: lllllllllllll -

RGU.l Wlth the single—document interface (SDI) : See ?Commander ) l[!] WARNING: The Windows version of the R Commander works best under




Loading, Orientation to Rcmdr GUI’s panels/menus

* After menu-load OR entering below in R GUI’s ‘console’ prompt see:

> library (Rcmdr)

o File Edit Data Statistics Graphs Models Distributions Tools Help
We will next break down these panels & == - oo ..

R Script R Markdown

< Note distinct tabs™ in top panel

Output

Messages

* For now, we stick to Script tab in top panel; R Markdown covered later

RRRRRRRRRRR

R Script R Markdown

|[3] NOTE: Hello wilkinskj

[4]

WARNING: The Windows wversion of the R Commander works best
|[RGui with the single-document interface (SDI):; see ?Commander.

under |




R RGui
File Edt View Misc Packages Windows Help

HEEIBRERIBIE

L ] [ ]
In S to l Ote I n I ' I I . ane S —
® R version 4.4.0 {2024-04-24 ucrt) -- "Puppy Cup"
Copyright {C) 2024 The R Foundation for Statistical Coxputing

Platform: x86_64-w64-mingw32/x64

R is free software and comes with ABSOLIUTELY NO KARRAMY.QRC‘”
You are welcome to redistribute it under certain conditic B Edt Yiew Mac Pactager Windows Heo

Iype 'license()' or ‘licence()‘ for distribution details. [Elaﬁl [EIEI(_‘,]

. I P n | (] t I b lt b’ b t Natural language support but running in an English loca R RConsole
O p a e [ ] Ca n Ogg e y a e We e n R 13 a collaborative project with many contributors. Loading required package: splines

TIype ‘contribuctors()® for more information and tosding required package: RomdrMisc

*citation() ' on how to cite R or R packages in publicatiqd 02ding required package: car
L03di1ng zequized package: ca:Daca

l g ’ ( ’ Zoading requared package: sancwich
Type ‘demo ()’ for soxe demos, 'help()' for on-line help, | Load:ng requized package: effecss
‘help.stazt() ' for an HTML browser interface to help. lattice thexe set by effectsThexze()

Iype 'q()' to qQuit R. See ?effectsTheme for details.

Romdr Version 2.9

library (R x

Atzaching package: ‘'Remd:r’

. ‘R Script’ panel: an edit-ready sub- ————

File Edt Data Statistics Graphs Models Distributions Tools Help

@ Data set: <No active dataset> Ednt data set j Viewdstaset  Modet | Z <No active model

window where code appears

* ‘Output’ panel: a non-editable sub-
window that ‘echoes’ code already

submitted to R ‘console’ & text-based
output when appropriate

* ‘Messages’ panel: a non-editable sub-
window to ‘surfaces’ R system ‘reply”

(3) NOTE: Bello wilkinsk)

]
[9) WARNING: The Windows version of the R Commander works best under
RGui with the single-document interface (SDI); see ?Commander. |



Things to note in Remdr: panels

* Top Panel: can toggle by ‘tab’ between
‘R Script’ & ‘R Markdown’ RScript o

. ‘R Script’ panel: an edit-ready sub-

R RGui
File Edt View Misc Packages Windows Help

HEEIBRRRIBIE

R R Console

R version 4.4.0 (2024-04-24 ucrt) -- "Puppy Cup”

Platform: x86_64-w64-mingw32/x69

Natural language support but running in an English locy

R 13 a collaborative project with many contributors.
TIype ‘contribucors()® for more information and
*citaction()* on how to cite R or R packages in publicatid

Type ‘demo ()’ for sozxe demos, ‘help()' for on-line hrelp,
‘help.start()' for an HITML browser interface to help.

Iype 'q()' to qQuit R.

laibrary (R x

Copyright (C) 2024 The R Foundation for Statistical Computing

R is free software and comes with ASSOLIUTELY NO NAI‘(RI.\N‘IY.Q"c‘”i
You are welcome to redistribute it under certain conditic B Edt Yiew Msc Pactager Windows Heo

Type 'license()* or ‘licence() ‘' for distribution details. [&156] [EIEI_{:,]

R R Console

Loading zequired package: splines
to8ding required package: RomdzMisc
Loading reQuired package: car
L03di1ng zequized package: ca:Data
loading requazed package: sandwich
Loadiag zequized package: effects
lattice thexe set by effectslheze()
See JYeffectsThemze for details.

Romdr Version 2.9-2

ching Dackaoe: "Rends®
ching package Remdr

window where code appears e e _
* ‘Output’ panel: a non-editable sub-
window that ‘echoes’ code already
submitted to R ‘console’ & text-based
output when appropriate
* ‘Messages’ panel: a non-editable sub-
window to ‘surfaces’ R system ‘reply’

(3) NOTE: Rello wilkinsk)

o
[4) WARNING: The Windows version of the R Commander works best under
RGuil with the single-document interface (SDI); see ?Commander.




Things to note in Remdr: panels

* Top Panel: can toggle by ‘tab’” betweer

/

‘R Script’ & ‘R Markdown’ R Script

. ‘R Script’ panel: an edit-ready sub-
window where code appears

* ‘Output’ panel: a non-editable sub-
window that ‘echoes’ code already
submitted to R ‘console’ & text-based
output when appropriate

* ‘Messages’ panel: a non-editable sub-
window to ‘surfaces’ R system ‘reply’
messages for code alreadyv submitted

R RCommander

@ Data set: | | <No active dstaset>

R RGui
File Edt View Misc Packages Windows Help

HEEIBRERIBIE

R R Console

R version 4.4.0 (2024-04-24 ucrt) -- "Puppy Cup”

Platform: x86_64-w64-mingw32/x64

Natural language support but running in an English locy

R 13 a collaborative project with many contributors.
TIype ‘contribucors()® for more information and
*citaction()* on how to cite R or R packages in publicatid

Type ‘demo ()’ for sozxe demos, ‘help()' for on-line hrelp,
‘help.start()' for an HITML browser interface to help.
Iype 'q()' to qQuit R.

laibrary (R x

Copyright (C) 2024 The R Foundation for Statistical Computing

R is free software and comes with ASSOLIUTELY NO KARRANTY.QRG‘”
You are welcome to redistribute it under certain conditic B Edt Yiew Msc Pactager Windows Heo

File Edt Data Statistics Graphs Models Distributions Tools Help

€dit data set | Viewdata st Modet | I <No active model

Type 'license()* or ‘licence() ‘' for distribution details. [Elaﬁl [EIEIE,]

R R Console

Loading zequired package: splines
to8ding required package: RomdzMisc
Loading reQuired package: car
L03di1ng zequized package: ca:Data
loading requazed package: sandwich
Loadiag zequized package: effects
lattice theze set by effectslheze()
See JYeffectsThemze for details.

Romdr Version 2.9-2

R3<npt R Markdown

Output

Messages

(3) NOTE: Bello wilkinsk)

[9) WARNING: The Windows version of the R Commander works best under
RGuil with the single-document interface (SDI); see ?Commander.

> Submit




R RGui
Eile Edit VYiew Muisc Packages Windows Help

HEEIBRERIBIE

Things to note in Rcmdr: panels e ——

Copyright (C) 2024 The R Foundation for Statistical Comxputing
Platform: x86_64-w64-mingw32/x69

R is free software and comes with ASSOLIUTELY NO NARRANIY.QRC‘”
You are welcome to redistribute it under certain conditic B Edt Yiew Msc Pactager Windows Heo

Iype 'license()' or ‘licence()‘ for distribution details. [&Iaﬁl [EIEIZ‘-,]

. I P n I (] n t I b It b’ b t Natural language support but running in an English loca R RConsole
O p a e [ ] C a Ogg e y a e We e I R i3 a collaborative project with many contributors. Loading required package: splines

TIype ‘contribucors()® for more information and toading required package: RomdrMisc
Loading reQuired package: car
L03di1ng zequized package: ca:Data

l e , ( ’ H Loading requazed package: sancwich
cr.p / Type ‘demo ()’ for soxe demos, ‘'help()' for on-line help, | Load:ng requized package: effec:ss

‘help.start()' for an HTML browser interface to help. latzice theze set DY effecisTheze()
Type *'qQ()' to qQuit R. See ZeffecrsThexe for dezails.

*citaction()* on how to cite R or R packages in publicatid

~

labrary (R x

*/ ‘R Script’ panel: an edit-ready sub- T

File Edt Data Statistics Graphs Models Distributions Tools Help

@ Data set: | || <No active dataset> Ednt data set | Viewdstaset  Modet |  <No active model

window where code appears s

* ‘Output’ panel: a non-editable sub-
window that ‘echoes’ code already L 5

submitted to R ‘console’ & text-based
output when appropriate

* ‘Messages’ panel: a non-editable sub-
window to ‘surfaces’ R system ‘reply” '

(3) NOTE: Rello wilkinsk)

p— []

Da. (49) WARNING: The Windows version of the R Commander works best under

Y i RGui with the single-document interface (SDI); see ?Commander. |
N’



R RGui
Eile Edit VYiew Muisc Packages Windows Help

HEEIBRERIBIE

R R Console

R version 4.4.0 ({2024-04-24 ucrt) -- "Puppy Cup”
Copyright (C) 2024 The R Foundation for Statistical Computing
Platform: x86_64-w64-mingw32/x69

Things to note in Remdr: panels

R is free software and comes with ASSOLIUTELY NO NARRANIY.QRC‘”
You are welcome to redistribute it under certain conditic B Edt Yiew Msc Pactager Windows Heo

Type °‘license() ' or ‘licence()‘' for distribution details. [&Iaﬁl [EIEIZ‘-,]

. I P n I ® n t I b lt b’ b t n Natural language support but running in an English loca 'R RConsole
O p a e [ ] C a Ogg e y a e We e R i3 a collaborative project with many contributors. Loading required package: splines

Iype ‘contribucors()® for more information and tosding required package: RomdrMisc

£ .
*citation()® on how to cite R or R packages in publicatig -©8ding required package: car
~03di1ng zequized package: ca:Deca

l e , l , H Loading requazed package: sancwich
cr.p / Type ‘demo ()’ for soxe demos, ‘'help()' for on-line help, | Load:ng requized package: effec:ss

‘help.start()' for an HTML browser interface to help. latzice theze set DY effecisTheze()
Type *'qQ()' to qQuit R. See ZeffecrsThexe for dezails.

~

labrary (R x

* ‘R Script’ panel: an edit-ready sub- T

File Edt Data Statistics Graphs Models Distributions Tools Help

@ Data set: | || <No active dataset> Ednt data set | Viewdstaset  Modet |  <No active model

window where code appears s

* ‘Output’ panel: a non-editable sub-
window that ‘echoes’ code already L 5

submitted to R ‘console’ & text-based
output when appropriate

* ‘Messages’ panel: a non-editable sub-
window to ‘surfaces’ R system ‘reply” '

(3) NOTE: Rello wilkinsk)

p— [

Da. (49) WARNING: The Windows version of the R Commander works best under

Y i RGui with the single-document interface (SDI); see ?Commander. |
N’



Things to note in Remdr: panels

* Top Panel: can toggle by ‘tab’ between

R Script

‘R Script’ & ‘R Markdown’

* ‘R Script’ panel: an edit-ready sub-
window where code appears

R R Comman der

R RGui
File Edit View Misc Packages Windows Help

R R Console

4-2

R

ngw:

co h ABSOLUTELY NO WARRANTY,®RGul

trib it unde =
ence ()" for di

© certain conditic file Edt View Misc Packages Windo
stribution details.

= ort but running in an English lo

R Console

* ‘Output’ panel: a non-editable sub-
window that ‘echoes’ code already
submitted to R ‘console’ & text-based
output when appropriate  oup

* ‘Messages’ panel: a non-editable sub-
window to ‘surfaces’ R system ‘reply’
messages for code already submitted

== [m] X
File Edit Data Statistics Graphs Models Distributions Tools Help
R Data set: <No active dataset> 7 Edit data set | @) View dataset  Model: | £ <No active model>
RScript R Markdown
1

Messages

[3] NOTE: Hello wilkinskj

[4] WARNING: The Windows versi
RGui with the single-document

on of the R Commander works best under
interface (SDI); see ‘

?Commander.




Things to use in Remdr: Filesystem via File>

‘R R Commander

File Edit Data Statistics Graphs Models Distributions Tools Help

‘File’ Menu: can select an active

Open script file...

‘working’ directory or OpSys ‘folder’

Save script as...

Open R Markdown file...

* Why? easier to select tiles to import | sermomnne.

Save R Markdown file as...

Save output...

* ‘R Script’ panel: shows ‘submitted’

Save R workspace...

setwd (..) call, with OS-chosen ‘folder’ | srvespscesn.

Exit »

* ‘Output’ panel: ‘echoes’ it
* Next choice in ‘File’ menu:

() NIDDK 75




Things to use in Remdr: Filesystem via File>

R R Commander

File Edit Data Statistics Graphs Models Distributions Tools Help

‘File’ Menu: can select an active

Open script file...

‘working’ directory or OpSys ‘folder’

Save script as...

Open R Markdown file...

* Why? easier to select tiles to import | sesmonne.

Save R Markdown file as...

| Save output...

v

ave output as...

* ‘R Script’ panel: shows ‘submitted’

:
!
l Save R workspace...
I

setwd (..) Call, with OS-chosen ‘folder’ | serwrmcs.

* ‘Output’ panel: ‘echoes’ it
* Next choice in ‘File’ menu:




Things to use in Remdr: Filesystem via File>

R R Commander

File Edit Data Statistics Graphs Models Distributions Tools Help

lFlleI M en u: Ca n SGIECt an active Change working directory... R . it data set | @) View data set

Open script file...

‘working’ directory or OpSys ‘folder’ e

Open R Markdown file...

* Why? easier to select tiles to import | sermmeomnae.

Save R Markdown file as...

Save output...

Save output as...

* ‘R Script’ panel: shows ‘submitted’
setwd (..) call, with OS-chosen ‘folder’

Save R workspace as...

|
|
l Save R workspace...
I

Ex it » PMAR

* ‘Output’ panel: ‘echoes’ it oo e e oo

\R) Dataset ' <No active dataset>|  Editdataset |i} Viewdataset Modek: | X <No active model>

R Script R Markdown

e e I F e I ’
. h m [ )
N eXt C O l Ce l n l e e n u o setwd ("C:/Users/wilkinsk)/OneDrive - National Institutes of Healch/Documents/Intramura
N ————————————————

Qutput

YYYYY




Things to use in Remdr: Filesystem via File>

R R Commander

File Edit Data Statistics Graphs Models Distributions Tools Help

‘File’ Menu: can select an active

Open script file...

‘working’ directory or OpSys ‘folder’

Save script as...

Open R Markdown file...

* Why? easier to select tiles to import | sermeomnae.

Save R Markdown file as...

| Save output...

*| ‘R Script’ panel: shows ‘submitted” | swosas
setwd (..) call, with OS-chosen ‘folder’| | .

Save R workspace as...

| Exit

( ) . ! ? 4 [@rcommanae
* ‘Output’ panel: ‘echoes’ it o o i e
ta s <No active da | ] 3 L]

f dit dataset & View dataset  Model: | X <No active B
N t P PY IF.I ’ g ot DA tosdas B This P
[ h n m o [
eX C O I Ce I I e e n u o .se:wd("C:/Uaerslvzlklnskj/OneDzlve - National Institutes of Health/Documents/Incr al
———————— 1




Things to use in Remdr: Filesystem via File>

R R Commander

File Edit Data Statistics Graphs Models Distributions Tools Help

‘File” Menu: can select an active

Open script file...

‘working’ directory or OpSys ‘folder’

Save script as...

Open R Markdown file...

* Why? easier to select files to import | sermomnne.

Save R Markdown file as...

Save output...

* ‘R Script’ panel: shows ‘submitted’ ot
setwd (.) call, with OS-chosen ‘folder’ | s

Save R workspace as...

[N

°
¢ f ' nel: ‘echoes’ it o
u p u p a e [ ] e e File Edt Data Statistics Graphs Models Distributions Tools Help
@ Data set No active da Edit dataset &) Viewdataset  Modek X <No active

B Ratons
. N t I ® ° IF.I ’ . :T(rn:*' DaR. L ~ I This X
eX C O I Ce I n l e l I | e l I u L] sectwd{"C:/Users/wilkinsk)/OneDrive - National Institutes of Health/Documents/Intramural
S —




Things to use in Remdr: Filesystem via File>

‘File” Menu: can select an active
‘Working’ directory or OpSys ‘folder’

* Why? easier to select files to import

* ‘R Script’ panel: shows ‘submitted’

{ V4 { ) ° e
* ‘Output’ panel: ‘echoes’ it [ e oo v oo

R‘ Data set: <No active dataset> * Edit data set
Ser

setwd (...) call, with OS-chosen ‘folder’ \

R R Commander

File Edit Data Statistics Graphs Models Distributions Tools

Change working directory...

Open script file...
Save script...
Save script as...

Open R Markdown file...
Save R Markdown file...
Save R Markdown file as...

Save output...
Save output as...

Save R workspace...

Save R workspace as...

Exit

_' Edit data set

Tools Help

g View dataset.  Model: | £ <No active model>

@ National Institut
. Next choice in ‘File’
n [ ]
eX C O I Ce I I e e u L setwd ("C:/Users/wilkinskj/OneDrive - National Institutes of Health/Documents/Intramural
—

Help

&) View data set

Select Folder Cancel

YYYYY



Orientation within Remdr GUI’s panels/menus

* Appearances of each (color-coding), by panel
° R Script: ‘Submitted’ code in Black ™ ®

setwd ("C:/Users/wilkinskj/OneDrive - National Institutes of Health/Documents/

* Output: ‘Echoed’ submission of code in Brown

Output

> setwd ("C:/Users/wilkinskj/OneDrive - National Institutes of Health/Documents/

* Messages
* Notes in Blue  wesse

[1) NOTE: R Commandexr Version 2.9%9-2: Thu Jul 24 16:53:46 2025{
(2) NOTE: R Version 4.4.0
[(3) NOTE: Hello wilkinskj

* Warnings in Green ..

[4])] WARNING: The Windows version of the R Commander works best under

RGui with the single-document interface (SDI); see 2Commander.

s E . R d Messages
rro rS ln e (5] ERROR: There is no active data set. . Y $ f vears
(6] ERROR: There is no active data set.
RROR: There ar t ts from which to ch . N K °
=) (7] ERRO ere are no data sets om whic 0 choose 'DD 7950207




Orientation within Remdr GUI’s panels/menus

* Appearances of each (color-coding), by panel
* R Script: ‘Submitted’ code in Black =

gsetwd ("C:/Users/wilkinskj/OneDrive - National Institutes of Health/[Documents/

* Qutput: ‘Echoed’ submission of code in Brown

Output

* Messages
* Notes in Blue  wesse

[1) NOTE: R Commandexr Version 2.9%9-2: Thu Jul 24 16:53:46 2024
(2) NOTE: R Version 4.4.0
[3) NOTE: Hello wilkinskj

* Warnings in Green ..

[4]) WARNING: The Windows version of the R Commander works best under
RGui with the single-document interface (SDI); see ?2Commander.

Messages

* Errors in Red

(S] ERROR: There 1is no active data set.
(6] ERROR: There is no active data set.

(7] ERROR: There are no data sets from which to choose.

©)



Orientation within Rcmmdr GUI’s panels/menus

* Appearances of each (color-coding), by panel
* R Script: ‘Submitted’ code in Black == "~

gsetwd ("C: /Users/wilkinskj/OneDrive - National Institutes of Health/

* Output: ‘Echoed’ submission of code in Brown

I=

}' Messages

* Notes in Blue  ves=-

[1] HOTE: R Commander Version 2.5-2: Thu Jul 24 16:53:46 202q

[2] HOTE: R Version 4.4.0
[3] HOTE: Hello wilkinskj

* Warnings in Green ...

[4] WAENTING: The Windows wersion of the R Commander works best under
RGui with the single-document interface (5DI); see ?Commander.

iwi si
Messages
[5] ERROR: There is no active data set. 0 Y 0 YEaRs
to choose. 7950207

[6] ERROR: There is no active data set
[7] ERROR: There are no data sSets o

* Errors in Red




Recmdr menus/panels

with some ‘history’

* Top Panel: keeping to ‘R Script’ tab
(currently, ‘R Markdown’ for later)

* ‘R Script’: code appears in Black as

you select actions on data via menu

* ‘Output’: ‘echoes’ code prior
submitted to R ‘console’ (in bkgrnd) |
in Brown WHILE text-based output
in Blue, as applicable... graphs later

* ‘Messages’: ‘surfaces’ R system
Notes in Blue while ‘reply’ messages
for code already submitted giving
Warnings in Green & Errors in Red

R R Commander — 0O

File Edit Data Statistics Graphs Models Distributions Tools Help
@ Data set: DIGdata / Edit data set View data set  Model): | £ <No active model>

R Script R Markdown

setwd ("C:/Users/wilkinskj/OneDrive - National Institutes of Healta/Documents/Intramural/_ BiostatsStrategy-in-IRP/Semina:
CTGdata <-
read.table ("C:/Users/wilkinskj/OneDrive - National Institutes of Health/Documents/Intramural/_ BiostatsStrategy-in-IRP,
headex=TRUE, stringsAsFactors=TRUE, sep=",", na.strings="", dec=".", strip.wnhite=TRUE)
CTGdata <-
readXL ("C:/Users/wilkinskj/OneDrive - National Institutes of Health/Docurents/Intramural/_ BiostatsStrategy-in-IRP/Sem
rownames=FALSE, header=TRUE, na="", sheet="ctg-studies CSV", stringsAsFactors=TRUE)
summary (CTGdata)
library(abind, pos=1€)

Output e Submit

> gsetwd("C:/Users/wilkinskj/OneDrive - National Institutes of Health/Documents/Intramural/ BiostatsStrategy-in-IRP/Semi

> CTGdata <-

+ read.table ("C:/Users/wilkinskj/OneDrive - National Institutes of Health/Documents/Intramural/ 3BiostatsStrategy-in-I
+ header=TRUE, stringsAsFactors=TRUE, sep=",", na.strings="", dec=".", strip.white=TRULE)

| > CTGdata <-

+ readXL ("C:/Users/wilkinskj/OneDrive - National Institutes of Health/Documents/Intramural/_ 3BiostatsStrategy-in-IRP/S
+ rownames=FALSE, header=TRUE, na="", sheet="ctg-studies CSV", stringsAsFactors=TRUE)

> summary (CTGdata)

NCT . Number
NCT00001723: 1
NCT00005669: 1
NCT00025883: 1
NCT00062764: 1
NCT000&3232: 1
NCT00711490: 1
(Othex) :10

Messages

[1) NOTE: R Commander Version 2.9-2: Thu Jul 24 16:53:46 202S

[2]) NOTE: R Version 4.4.0

[3) NOTE: Hello wilkinsk)

|[4) WARNING: The Windows version of the R Commandex works best undex
4




Rcmdr menus/panels with some ‘history’

R R Commander - [}

[ ]
* Top Panel: keeping to ‘R Script’ tab
Op ane [ eeplng O C Ip a File Edit Data Statistics Graphs Models Distributions Tools Help
m Data set: DlGdata _ZEditdataset |5} View data set.  Model: | £ <No active model>

(currently, ‘R Markdown’ for later) ... ...

setwd ("C: /Users/wilkinskj/CneDrive — National Institutes of Health/Documents/Intramural,/ BiostatsStrategy-in-IRP/Semina:

[ ] []
° ‘R ript’: code appears in Black as ==
° ‘ read.table ("C:/Users/wilkinskj/OneDrive - National Institutes of Health/Documents/Intramural/ BiostatsStrategy-in-IRP,

header=TRUE, stringshAsFactors=TRUE, sep=",", na.strings="", dec=".", strip.white=TRUE)

CIGdata <-

L] L]
| t t d t m | readXL ("C: /Users/wilkinskj/OneDrive - Nationmal Institutes of Health/Documents/Intramural/ BiostatsStrategy-in-IRP/Sem
yo u Se e C a C I O n S O n a a VI a e n u rownames=FALSE, header=TRUE, na="", sheet="ctg-studies C5V", stringsisFactors=TRUE)
summary (CTGdata)
library(abind, pos=16)

| l“"ﬁ Submit

* ‘Output’: ‘echoes’ code prior
submitted to R ‘console’ (in BKGINA) | o i i smiesees o cosonssmeees samseess_somesesevesiss oo s

. > CTGdata <-
I n B row n WH IL E text_ b a Se d O u t u t |+ read.table ("C:/Users/wilkinskj/OneDrive - National Institutes of Health/Documents/Intramural/ BiostatsStrategy-in-I
+ header=TRUE, stringsAsFactors=TRUE, sep=",", na.strings="", dec=".", strip.white=TRUE)

| |» CIGdata <-

L] L
I n B I u e a S a | I Ca b I e ra hs /a ter + readXL ("C:/Users/wilkinskj/Onelrive - National Institutes of Health/Documents/Intramural/_ BiostatsStrategy-in-IRF/S
’ LN ] | |+ rownames=FALSE, header=TRUE, na="", sheet="ctg-studies C5V", stringsAsFactors=TRUE)

> summary (CTGdata)
| NCT . Humber

* ‘Messages’; ‘surfaces’ R system

NCT00005669:

NCTO00Z5883:
NCTOO00e2764:

Notes in Blue while ‘reply’ messages ===

WCTOO0711490:

[

(Cther) He g

for code already submitted giving | ...

[1] HOTE: R Commander Versionm 2.9-2: Thu Jul 24 16:53:46 2025

Warnings in Green & Errors in Red | & & s

[4] WARNING: The Windows wversion of the R Commander works best under




Orientation within Remdr GUI’'s menus: Data (1)

Importing data from multiple formats

* Excel-able files: .csvor xisx (or character-delimited .txt files); NUANCED

® R Commander
File Edit Data

gv DJ

Statistics Graphs Models

New data set...
Load data set...

Distributions Tools Help

} set View data

* Other analytic platforms’ files: sas (.sas7bdat) or Stata or SPSS

e Each ‘file’/'worksheet’ becomes aR ‘data. frame’

* Designating mgest settings, becomes Actlve data

@R Read Text Data From File, Clipboard, or URL

Enter name for data set: CTG data|

X |

Variable names in file:
Convert character vanables to factors
Missing data indicator:

Location of Data File

O Local file system

O Clipboard

O Internet URL

Field Separator

O White space © Commas[]

O Semicolons ;] O Tabs

O Other  Specify:

Decimal-Point Character

© Period | ]

O Commal,)

@Help l JOK I xCancel

@ Read Text Data From File, Clipboard, or URL

Enter name for data set: Dataset
Variable names in file:

Convert character variables to factors

Missing data indicator: NA

Location of Data File

O Local file system

O Clipboard

O !nternet URL

Field Separator

O Whitespace (O Commas|,]

O Semicolons ;] O Tabs

O Other  Specify:

Decimal-Point Character

O Period [.]

O Commal,]
@ Help

J oK x Cancel

X

A 4

[Simporta

Data in packages
Active data set

v v v

Manage variables in active data set

:

: Merge data sets...
R Script R | g I
Import data from text file, clip
Data in packages from SPSS data se
Active data set from SAS xport fil
Manage variables in active data set from SAS b7dat fi
from Minitab dat:
from STATA data
from Excel file...
@ R Commander
File Edit Data Statistics Graphs Models Distributions Tools Help
New data set... t .
@ Da set | View data set odel: | £ <No act
Load data set... =
R Script R | Merge data sets... [

from text file, clipboard, or URL...
from SPSS data set...

from SAS xport file...

from SAS b7dat file...

from Minitab data set...

from STATA data set...

from Excel file...




Orientation within Remdr GUI’'s menus: Data (1)

Importing data from multiple formats

° Excel-able files: .csv or xisx (or character-delimited .txt files); NUANCED
* Other analytic platforms’ files: sas (.sas7bdat) or Stata or SPSS
* Each ‘file’/'worksheet’ becomes aR ‘data. frame’

® R Commander
File Edit Data

gv DJ

Statistics Graphs Models

New data set...
Load data set...

Distributions Tools Help

} set View data

* Designating mgest settings, becomes Actlve data

@R Read Text Data From File, Clipboard, or URL

X |

X

CTGdata)

l Enter name for data set:

@ Read Text Data From File, Clipboard, or URL
Dataset

Enter name for data set:
; infi m

Convert character vanables to factors
Missing data indicator:

Location of Data File

O Local file system

O Clipboard

O Internet URL

Field Separator

O White space  © Commas []
O Semicolons ;] O Tabs

O Other  Specify:
Decimal-Point Character

© Period (]

O Commal,)

@Help l JOK I xCancel

Convert character variables to factors
Missing data indicator: NA
Location of Data File

O Local file system

O Clipboard

O Internet URL

Field Separator

O Whitespace O Commas|[,]

O Semicolons ;] O Tabs

O Other
Decimal-Point Character
O Period [.]

O Commal,]

& Hep

Specify:

J oK x Cancel

: Merge data sets...
R Script R | g I
Import data from text file, clip
Data in packages from SPSS data se
Active data set from SAS xport fil
Manage variables in active data set from SAS b7dat fi
from Minitab dat:
from STATA data
from Excel file...
@ R Commander
File Edit Data Statistics Graphs Models Distributions Tools Help
New data set... t .
@ Dal set | View data set odel: | £ <No act
Load data set... =
RScript R|  Mergedata sets... I

\ 4

[Simporta

Data in packages
Active data set

v v v

Manage variables in active data set

:

from text file, clipboard, or URL...
from SPSS data set...

from SAS xport file...

from SAS b7dat file...

from Minitab data set...

from STATA data set...

from Excel file...




Orientation within Remdr GUI’'s menus: Data (1)

Importing data from multiple formats

* Excel-able files: .csvor xisx (or character-delimited .txt files); NUANCED

® R Commander

File Edit Data Statistics Graphs Models Distributions Tools Help

g\ DJ

New data set...
Load data set...

} set View data

R Script R| Merge data sets...
| SR
® O h | . | f /] f' I . Import data from text file, clip
t er a na ytlc p at Orl ' 'S I es- SAS (.SaS7bdat) or Stata or SPSS Data in packages from SPSS data se
Active data set from SAS xport fil
° h lf' I ) J¢ k h V4 b { ) Manage variables in active data set from SAS b7dat fi
Each ‘file’/‘worksheet’ becomes aR ‘data. frame
from STATA data
from Excel file...
° D ti t setti becomes Active dat
esignating ingest settings, becomes C Iveé dadlad
@ Read Text Data From File, Clipboard, or URL X | @ Read Text Data From File, Clipboard, or URL X | @ R Commander
Enter name for data set: CTGdata) — Enter name for data set: Dataset File Edit Data Statistics Graphs Models Distributions Tools Help
= ‘ - - = 'I New data set... | | - t :
j—Coned characteryanahlesto factors € —Conyert character variablesto factors @ Da set | View data set odel: | £ <No act
Missing data indicator: Missing data indicator: NA Load data set...
—roestomof-Butetie ‘ Dot RScript R{  Merge data sets..
O Local file system O Localfile system
O Clipboard O Clipboard \ from text file, clipboard, or URL...
O Internet URL O intemet URL Data in packages »|  from SPSS data set...
~ Field S -
ng;:i‘::r:;:;e O Commas [ ; W':T::::Cre O Commas [,] Aciwe dafnsel ’ fromSAixgort fe.,
O Semicolons[;] O Tabs O Semicolons ] O Tabs Manage variables in active data set > from SAS b7dat file...
O Other  Specify: O Other  Specify: from Minitab data set...
Decimal-Point Character Decim.aI~Point Character : from STATA data set...
© Period [] O Period | ] .
O Commal,) O Commal,] from Excel file...
@Help l J oK I x Cancel @Help J oK . x Cancel

(o)




Orientation within Remdr GUI’'s menus: Data (1)

Importing data from multiple formats

* Excel-able files: .csvor xisx (or character-delimited .txt files); NUANCED
* Other analytic platforms’ files: sas (.sas7bdat) or stata or SPSS
* Each ‘file’/‘worksheet’ becomes aR ‘data. frame’

(R R Commander

New data set...
Load data set...
Merge data sets...

g\ DJ

R Script R |

Import data

Data in packages

Active data set

Manage vanables in active data set

Designating ingest settings, becomes Active data

@ Read Text Data From File, Clipboard, or URL

X |

@ Read Text Data From File, Clipboard, or URL

X Z

File Edit Data Statistics Graphs Models Distributions Tools Help

} set View data

from text file, clip
from SPSS data se
from SAS xport fil
from SAS b7dat fi
from Minitab dat:
from STATA data
from Excel file...

@ R Commander

File Edit Data Statistics Graphs Models Distributions Tools Help

New data set...

@ Dal —1 set

Load data set...
R Script R | Merge data sets... [

Data in packages

Enter name for data set: CTGdata| — Enter name for data set: Dataset
L] ‘ : infi |
\—Cooved characterxanahlesto factors | —Conyert character vadablesto factors 9
Missing data indicator: Missing data indicator: NA
rocctomai-Bitare . Dateki
O Local file system O Local file system
O Clipboard O Clipboard
O Internet URL O !nternet URL
T P —
() White space  © Commas|,] O Whitespace O Commas]
: T semicolons 1] L 1abs = SEMICOONE T L) T30%

O Other  Specify:
Decimal-Point Character

© Period []
O Commal,)

@Help l JOK I xCancel

»
Active data set 4
>

O Other  Specify:
Decimal-Point Character
O Period | ]

O Commal,)

@Help J OK x Cancel

:

Manage variables in active data set

from Excel file...

() View data set

from SPSS data set...
from SAS xport file...
from SAS b7dat file...
from Minitab data set...
from STATA data set...

odel: | £ <No act




Orientation within Remdr GUI’s menus: Data (1)

R R Commander

Importing data from multiple formats

File Edit Data Statistics Graphs Models Distributions Tools

>  Dal New data set...
) al
’R | Load data set...
R Scnpt Rt

Help

 Excel-able f”ESZ .csv or .xlsx (or character-delimited .txt files); NUANCED

I set | | View data

Merge data sets...

Data in packages

from text file, clip
from 5PS5 data se

* Other analytic platforms’ files: sas (.sas7bdat) or Stata or SPSS

* Each ‘file’/*worksheet’ becomes a R ‘data. frame’ e [

from Excel file...

* Designhating mgest settings, becomes Active data

II Read Text Data From File, Clipboard, or URL x|

R Read Text Data From File, Clipboard, or URL X ! R R Commander
| Enter name for data set: CTGdata| Enter name for data set: Dataset File Edit Data Statistics Graphs Models Distributions Tools HEIP
. | ‘ " New data set... i
—Convert charactervariablesto factors | Conver charactervariablesto factors R set | View data set
Missing data indicator: Missing data indicator: NA Load data set...
Leatiomai-Batadik (Lo D T Merge data sets...

R Script R[

© Local file system © Local file system

O Clipboard O Clipboard ll Import data »| from text file clipboard, or URL...
O Internet URL () Internet URL Data in packages 4 from SPSS data set...
——ri=aSeparetor Fretd-Geparater ] )
. ¢
(O White space @ Commas|[] © Whitespace () Commas|,] Active data set from SAS x pOI't fllle
T TTSermcotons T T30: T CETTCETONE T T TIeE Manage variables in active data set k| from SAS b7dat file...
| OOther  Specify O Other  Specify: from Minitab data set...
Decimal-Point Character Decimal-Point Character | i STATA ks ot
© Period [.] © Period [] )
O Commal] O Commal,] from Excel file...

@Help x Cancel




Orientation within Rcemdr GUI's menus: Data (2)

* For sake of REPRODUCIBILITY, we can save ‘R Script’ code made so far

mander
Dats Geophn  Modeh  Onbietsav  Toch  Help
CERSEREoY SAH)S F Bt taret (@ Voewdataset  Mudet | X < No active models

Bx1/Cnabsive - Xationsl Iastizuzes of Mealth/Oocizenzy/intzes

m) ;. YYYYY ;
7950-203°

NIDDK



Orientation within Remdr GUI’'s menus: Data (2)

For sake of REPRODUCIBILITY, we can save ‘R Script” code made so far

R R Commnce Messages

R WU [10] NOTE: The dataset CIGdata has 16 rows and 19 columns.

e er e —" [11) NOTE: Script saved to C:/Users/wilkinskj/OneDrive - National Institutes of

e d kinska/OneDrave - Notionsl Tnstitutes of Mealth/Oocuments/In

Srve R Makdonn fle Joctore=TRUL, »ep™=,®, 0a.eTIings="", dec=".°, #Trip.whise~IN ° ° ° o o

S| NOTE: as this is an operating-system-level action, it only gets shown by

Seve Outprd ot | . ° ) L]

mImn Recmdr in Blue rather than being ‘echoed’ as R commands in Output in Brown




Orientation within Remdr GUI’'s menus: Data (2)

* For sake of REPRODUCIBILITY, we can save ‘R Script’ code made so far

e Messages
m‘&:”?:‘;%:‘;m:;m” [10] NOTE: The dataset CTGdata has 16 rows and 19 columns.
e | — [11]) NOTE: Script saved to C:/Users/wilkinskj/OneDrive - National Institutes of
B e .lllnltjlond?rlve - lotionel Inatitutes of Nealth/Oocument s/ Int
SeveRHartdomn e Jactore=TRUL, #ep=°,°, Rna.pcrings="", dec="., #IripP.white~TN ° ° ° 5 .
S| NOTE: as this is an operating-system-level action, it only gets shown by
Seve OV ot |
o Rcmdpr in Blue rather than being ‘echoed’ as R commands in Output in Brown

* With .R file saved for opening & running later, can reproduce data import

e Note: if we want to save time running errors, can remove .csv lines; NB: 'View'issues

* With imported data as an Active dataset, can make summaries

m) ;' YYYYY ;
7950-203

6 NIDDK



Orientation within Remdr GUI’'s menus: Data (2)

* For sake of REPRODUCIBILITY, we can save ‘R Script’ code made so far

P Messages
“«ii&ﬁiﬁfimﬁl” [10] NOTE: The dataset CTGdata has 16 rows and 19 columns.
_%;-—me PSSS— [11]) NOTE: Script saved to C:/Users/wilkinskj/OneDrive - National Institutes of
e T e - Netionel Institutes of Nealth/Oocuments/In
Save R Maskdoan fle Factore=TRUL, #¢p=",°, A4.aTIings="*, dec=".%, #TriP.vhite~TN ° ° ° ° °
S B . NOTE: as this is an operating-system-level action, it only gets shown by
oz Remdr in Blue rather than being ‘echoed’ as R commands in Output in Brown

* With .R file saved for opening & running later, can reproduce data import

e Note: if we want to save time running errors, can remove .csv lines; NB: 'View'issues

* With imported data as an Active dataset, can make summaries

[
® R Commander

File Edit Data Statlstlcs Graphs Models Distributions Tools Help

Active data set
Q Data set

Contingency tables Numerical summaries..

R Script R Markd& Means Frequency distributions...

Proportions Count missing observations

setwd ("C:/Us

CTGdata <-
read.tabl= Dimensional analysis

header='1'R Fit models Test of normality...

CIGdata <- Transform toward normality...
re=adXT. (. /TTQ.—-YQ/J 1lrinals /On e Nreersr—cw—

l:l(l

Nonparametric tests Correlation matrix...

>
>
>

‘ Variances » Table of statistics...
>
4 Correlation test...
>




Orientation within Remdr GUI’'s menus: Data (2)

* For sake of REPRODUCIBILITY, we can save ‘R Script’ code made so far

s Messages
“«ﬂxﬁ?#}fwmﬁlu [10] NOTE: The dataset CTGdata has 16 rows and 19 columns.
'Erﬁi*—]}&mm — [11]) NOTE: Script saved to C:/Users/wilkinskj/OneDrive - National Institutes of
Open R Markom e d k1nsky/ OneDrave - Motionsl Tastitutes of Heslth/Oocumence/in
e H . NOTE: as this is an operating-system-level action, it only gets shown by
oz Remdr in Blue rather than being ‘echoed’ as R commands in Output in Brown

* With .R file saved for opening & running later, can reproduce data import

e Note: if we want to save time running errors, can remove .csv lines; NB: 'View'issues

* With imported data as an Active dataset, can make summaries

R R Commander

File Edit Data Statistics Graphs Models Distributions Tools Help

Q Data set:

Contlngency tables » ‘ Numerical summaries...

R Script RMarkdd Mean' - R Question | X |
' Propo

Varian

setwd ("C:/Us Nonp. o There are 19 variables in the data set CTGdata.

CIGdata <- : Do you want to proceed?
read.tablsg Dimer

header=TR Fit mc

CTGdata <- __d oK [ Cancel J
ye=2AXT. I /TTasra /

©)



Orientation within Rcmdr GUI’s menus: Data (2)

* For sake of REPRODUCIBILITY, we can save ‘R Script’ code made so far

Messages

. [10] NOTE: The dataset CIGdata has 16 rows and 19 columns.
[11] NOTE: Script saved to C:/Users/wilkinskj/OneDrive - National Institutes of

NOTE: as this is an operating-system-level action, it only gets shown by
Recmdr in Blue rather than being ‘echoed’ as R commands in Output in Brown

* With .R file saved for opening & running later, can reproduce data import

4

* Note: if we want to save time running errors, can remove .csv lines; NB: '\View'issues

* With imported data as an Active dataset, can make summaries

R R Commander
Output ‘Z;jf‘;, Submit
File Edit Data Statistics Graphs Models Distributions  Toocls  Help F
) Data set Summaries g Active data set > summary (CIGdata) . ,
ata set: ; . : MCT . Mumber d d f
R Contingency tables  »|  Numerical summaries.. wonsso And Remdr generates a generic ‘summary’ o
M — - NCTOO005669: 1 . .
: £an . [ 25883: bI I f d h d
RScript R Markdo | ‘R’ Question X merocozsezs: 1 V/alld es/columns, after comman IS echoe
| 2764:
PFDFI'U HCTOO0063232: 1 .
Variar . | meroomisso: summary (CTGdata)
setwd("C:/Us - . (Other) :10
Nonp| There are 19 variables in the data set CTGdata. | Study.Titl
CTGdata <- : Do you want to prﬂ.ceed? [r— A Pilot Study for the Evaluation of Minocwycline as a Microglia Inmhibitor in the Treatment of Diabetic Macular Edema: 1
read.takbls D‘IFI"IETE | Effects of Roflumilast on Insulin and Blood Sugar Levels in Prediabetic Overweight and Obese Individuals HE
- | Leptin to Treat Lipodystrophy HEs
header=TR Flt mc Metformin to Treat Obesity in Children With Insulin Resistance : 1
CTGdata <-— GK CEHCE' 1 Mifepristone Effects on Glucose Intolerance in Obese/Overweight Adults HEn
readNT (M. TTasra | Howvel Therapy to Preserve Beta Cell Function in New Onset Type 1 Diakbetes Ham
. (Other) ;10
Study.URL Study.Status
https://clinicaltrials.gov/study/NCTO0001723: 1 COMPLETED :14




Orientation to Rcmdr GUI’s menus: Data—>Summaries(1)

* With Active Dataset, can do more specific summaries of interest:

R Groups

LLLLLLLL

B nep 9 Reset |  x ¢ Conce  @P apoly




Orientation to Rcmdr GUI’s menus: Data—>Summaries(1)

* With Active Dataset, can do more specific summaries of interest:
* What if interested in how CTG studies’ enrollment numbers are by status?

R Numencal Summanes X
@ RCommander . > numSummary (CTGdata([, "Enrollment”, drop=FALSE], statistics=c{"mean", "sd", "IQR", "quantiles"), quantiles=c(0, .25,
8 171134
File Edit Data Statistics Graphs Models Distributions Tools Help Vaiisbles (pick Gl + S, 75, 1))
' isbles (pick one of mor = ‘
QR Outoser R Active doto set P P - mean sd IQR 0% 25% 50% 75% 100% n
| Contingency tables > NERRNEET S . 38.375 52.8821 23.75 4 6.75 21.5 30.5 200 16
RScript R Markdg Means » Frequency distributions... Sumemarize by groups...
Proportions » Count missing observations
Variances L4 Table of stads¥cs...
secwd ("C:/Us . 5 Cortelati .
CTGdata <- Nonparametric tests _ortelation matrix...
read.tabla Dimensional analysis 4 Correlation test...
header=IR  Fit models » Test of normality... O e @ eeset o 0 K e | A apply
CIGdaca <- Transform towar dhormality... i
amadUT [0 It mmava feas Vrs mnmton INeaT
B Non
R Groups X
Date Sestodes
Variables (pick one oy mare) Groups variable (pick cne)
3

Collaborators |

o Completion.Date

) Conddions
_Summonu by geoups.. I Interventions

Locations

[ & o | ;M Cancel

@N!ip 4 Resat o oK ® Cancet @ Appiy

NIDDK 75

Z
950-203°



Orientation to Rcmdr GUI’s menus: Data—>Summaries(1)

* With Active Dataset, can do more specific summaries of interest:
 What If interested in how C TG studies’ enrollment numbers are by status?

R Numenical Summanes

@ R Commander e > numSummary (CTGdata[, "Enrollment”, drop=FALSE], statistics=c{("mean", "sd", "IQR", "quantiles"), quantiles=c(0, .25,
File Edit Data Statistics Graphs Models Distributions Tools Help l"':‘momo 1 .5,.75,1))
QR vwoser i Active data set R mean sd IQR 0% 25% 50% 75% 100% n
[ sEerieTnactabl i r— - 38.375 52.8821 23.75 4 6.75 21.5 30.5 200 16
RScnipt RMarkdg Means » Frequency distributions... Sumenarize by groups...
Proportions D Count missing observations
Variances > Table of staddics...
secwd ("C:/Us R . .
CTGdata <- Nonparametric tests ’ Coreelation matrix...
:ead.tab&e Dimensional analysis  ®|  Corcelation test... ) .
ne d =IR  Fit models > | Test of normality... @) Hep 9 Reser o K I conce | @ apply
-TGdaza <- | Transform toward normality...
4
° Overa || IS a bove Whl|e grou P- -based’ below via menus for factors
R Groups
Data Seatistic
€5 (pick one or mare) Groups variable (pick cne)
Age
Collaborator |
Completion.
Conddtions.
Intervent:ons
aaaaaaaa
J & ® el

(o)



Orientation to Rcmdr GUI’s menus: Data—>Summaries(1)

* With Active Dataset, can do more specific summaries of interest:
* What if interested in how CTG studies’ enrollment numbers are by status?

R Numencal Summaries X
@® R Comeander - > numSummary (CTGdata[, "Enrollment”, drop=FALSE], statistics=c ("mean", "sd", "IQCR", "quantiles”), quantiles=c(0, .23,
File Edit Data Statistics Graphs Models Distributions Tools Help v.i.bl:'(::mw'mw + .5,.75,1))
QR ostoser EDEEER  Active dota set P - mean sd IOR 0% 25% 50% 75% 100% n
| Contingency tables v 38.375 52.8821 23.75 4 6.75 21.5 30.5 200 16

Frequency distabutions... Sumemarize by groups...

RScript RMarkdg ~ Means
Count missing observations

»
»
Proportions L
Variances L4 Table of stadsuics...
setwd ("C:/Us R 5 Cortelati .
CTGdata <- Nonparametric tests _ortelation matrix...
»
»

read.tabla Dimensional analysis Coreelation test...

header=IR  Fit modeis Test of normality... O e @ eeset o 0 K e | A apply
‘IGdaca <- Transform toward normality... i
amadUT 10 It mmvalees V1os mmton [ NanT
[ ot l ’ :
° verdll IS dbove, wnlie roup-nase elow via menus Tor factoi
4 [}
®
® No
= . @® Groups X
@ R Commander L R Groups X Data Statistics
Stobes . : Groups vanable (pick
File Edit Data Statistics Graphs Models Distibutions Tools Help Variables (pick one ormare) | Oroups variable {pick one) Variables (Pick one or more} 3 cnp {pick one)
; : frbert— EREAS COCTTE—— - U
Y | Summaies > JEERORLITRS cohbontors | Satbae
ata set: . " b . Desi
Coningercyos I - e |
RScript R Markd Means » Frequency distributions... _SM] Interventions Summarize by groups.. .S:ooy,mle
Proportions *  Count missing obseivations JLocetions : Stody.Type
setwd ("C:/Us Variances ‘ : Table ol_siatistics-... _J oK | M Cancel I J Ol(__‘| 8 Concel
CIGdata <- Nonparametric tests Correlation matrix... o -
vead.table Oimensional analysis 4 Correjation test... T ——
headexr=TR  Fit models L4 Test of normality... @mz ) y
{ P Reset g x o o FP Apply & ! ] .
CiGdata <- Transform toward normality... @H‘Jp h Reset || o OK | R cance ¥ 2ppy
CANAVY 1IN, Il less YT nAated AN -T

m 7

@) NIDDK /%



Orientation to Rcmdr GUI’s menus: Data—>Summaries(1)

* With Active Dataset, can do more specific summaries of interest:
* What if interested in how CTG studies’ enrollment numbers are by status?

@ R Commander
File Edit
[ Summaries ]
@ Dataset | - k
| Contingency tables L4
RScript RMarkdg  Means 4
Proportions »
Variances .
setwd ("C:/Us R
CTGdata <- Nonparametric tests  »
read.tabla Dimensional analysis >
header=IR  Fit models »
“TGdata <-
madUT IS, It mmvam feas Vos manton [ NaaTi

Data Statistics Graphs Models Distributions  Tools Help

Active data set

Numerical sum maries..,

Frequency distributions...
Count missing observations
Table of stadsics...
Correlation matrix...
Correlation test...

Test of normality...

Transform toward normality...

* Overall is above, while ‘group-based’ below via m

@ R Commander
File Edit Data Statistics Graphs

@ oo IR
ata [

Contingency tables »

RScript RMarkdg €M »

Proportions

Vari »

secwd ("C:/Us sl ) i
CIGdata <- Nonparametric tests

read.table Oimensional analysis

header=TR  Fit models »

CIGdata <-

CANAVY RS, Itlanvnless Yes nated [An T

Models Distributions

Tools Help

Active data set

Frequency distributions...
Count missing obseivations
Table of statistics...
Correlation matrix...
Correlation test...

Test of normality...

Transform toward normality...

R Numencal Summanes

D2tz Syatistics

Vaiisbles (pick one or more)

Sumemanze by groups...

O e @ Reset

Dats Statobes

Vasiables (pick one or more)

Sumnmidrize by geoups -

Orep b Reset

X

> numSummary (CTGdata([, "Enrollment™,

+ .5,.75,1))
mean sd
38.375 52.8821 23.75

IQR 0% 25%

O« K e | @ appy

@ Groy X
R Groups x Data Staristics 4
Groups variable (pick one) Variables (pick one or more) f’ouosv"“bre (pick one)
0

Rge ol P
Collaborators at.Date
Completion.Date ~ Study.Design
Conditions EEEJE—! a!_ [
Interventions 'Summmu by groups... Study.Tntle
Locations Study.Type

g * ® el § Cancel

» A 4
oK | R conce | P dory @ view 94 Reset 9 Concd ¢P Appy

50%
4 6.75 21.5 30.5

drop=FALSE]), statistics=c ("mean", "IQR",

ngdn,

"quantiles™), quantiles=c (0, .25,

75% 100% n
200 16

‘r@ Read Text Data From File, Clipboard, or URL

CTGda

Vanable names in file:

i Enter name for data set:

| Convert character variables to factors

YEARS

NIDDK

7
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Orientation to Rcmdr GUI’s menus: Data—>Summaries(1)

* With Active Dataset, can do more specific summaries of interest:
* What if interested in how CTG studies’ enrollment numbers are by status?

R Numencal Summaries X
@ R Commander - > numSummary (CTGdata[, "Enrollment”, drop=FALSE], statistics=c ("mean", "sd", "IQR", "quantiles”), quantiles=c(0, .25,
File Edit Data Statistics Graphs Models Distributions Tools Help Vui.bl:(:::mmarmovg) + .S, '75’1))
QR ovteser IEEEEEE  Active dato set P - mean sd IQR 0% 25% 50% 75% 100% n
i i At - 38.375 52.8821 23.75 4 6.75 21.5 30.5 200 16

Frequency distributions... Sumenarize by groups...

RScript RMarkdg ~ Means
Count missing observations

»

»

Proportions »
Variances L4 Table of stadskics...

secwd ("C:/Us . . .
CTGdata <- Nonparametnc tests  * Corcelation matrix...
read.cabla Dimensional analysis P Correlation test...

header=TE  Fit models » Test of normality... O e @ Reset 0% K e | @ appy
-TGdaca <- | Transform toward normality... -

CmadUT IS IPTamv s fees YV 1rs mmton [T

* Qverallis above, while ‘group-based’ below via rr}enus\jatjﬁtor

@® Groups X

RG X - . 4
@ R Commander s e Gebuge Data Statisics s e ons (R Read Text Data From File, Clipboard, or URL
. . roups vanal
File Edit Data Statistics Graphs Models Distributions Tools Help Variables {pick one or more) ﬁ""'""’”"bﬂp"“m" [‘ﬁ’f"iwd Sponsor Sl
m- 5 ne imen! a
@ Data set I Active data set Collaborators | . Stact Date |
set : " Study.
15t [T Contingency tables  » QR oot e — | ' Enter name for data set: CTGda
RScript R Markd Means ¥ Frequency distributions... _Summui:ebygcoups..l Interventions Summarize byngPsu[ Study. Ttle |
Proportions »|  Countmissing obseivations e Bludy.pe Variable names in file:
" ! e

setwd ("C:/Us Variances . i Tableol_s!ansucs.... _J oK | R Cancel I J Ol(__‘| % Conce | ‘
CIGdata <- AR gt ic reet Sl ARt R { Convert character variables to factors

read.table Oimensional analysis  » Correlation test... — —

header=TR  Fit models *|  Testof normality... rep 4 Reset 7 x 9 Coc | PP Appy f—] i
CiGdata <- Transform toward noimality... ©Hﬂp B Reet || o OK | K canca PP appty

WANAVY INM, It vanless T s nAated /AN

YEARS

NIDDK




Orientation to Rcmdr GUI’s menus: Data=> Summaries(1)

* With Active Dataset, can do more specific summaries of interest:

* What if interested in how CTG studies’ enrollment numbers are by status?

R Numerical Summaries X

R R Commander oo o > numSummary (CTGdata[, "Enrollment”™, drop=FALSE], statistics=c("mean", "sd", "IQR", "guantiles"), guantiles=c(0,.25,
ata Statistics.

File Edit Data Statistics Graphs Models Distributions Tools Help + J5,.75, 1))

Variables (pick one or more)

R pata et [ LI Active data set Fﬂﬂm— mean sd IQR 0% 25% 50% 75% 100% n

Contingency tables [ ETEETIE 38.375 52.8821 23.75 4 €.75 21.5 30.5 200 16
R Script R Markda Means 3 Frequency distributions... Summarize by groups..
Propoertions 3 Count missing observations
Variances L3 Table of statistics...
setwd ("C:/Us . X R
CTGdata <- MNonparametric tests Caorrelation matrix...
read.cablg Dimensional analysis > Correlation test...
header=TR Fit models 4

Test of normality... @ Help 4y Reset ¥ concel [ F‘i Ap‘p"\;

Transform toward normality...

e m AT AW STTamen feed 2 TeS i les fm T

* Overall is above, while ‘group-based’ below via m

R Numerical Summa)

umerical Summaries X —
R Groups X
{ R G X Dat 1 = o
R R Commander I — s Seatistics . et | “R' Read Text Data From File, Clipboard, or URL
: : : : | : roups variable (pick one)
File Edit Data Statistics Graphs Models Distributions Tools Help Variables (pick one or mare) w Masalie=p KunelounoE] Sponsor
ge
R Data set: Active data set Collaborators | z:ardt.DSta
: i Completion.D: udy.Design | .
Contingency tables  * (Completion.Date | Enter name for data set: CTGda
RScript R Markdg =~ Means 4 Frequency distributions... mmarize by groups. Interventions M
Proportions 14 Count missing observations [Locations variable names in f|le n
setwd ("C: /TS Variances . : Table of.statistic?‘.. 3¢ cancel | )
crodate oo | MNonparametrictests Correlation matric.. e | Convert character variables to factors [
read.tabld Dimensional analysis L4 Correlation test...
header=TH Fit models L4 Test of normality...

& Hele 4 Reset 9 Cancel | @ Apply B Hen @ et

9 cancd | Apply

CIGdata <-—

e AVT Wy [Tlame o fr28 1 1es mmled JAmaTe

Transform toward normality...

S \
> numSummary (CTGdata[, "Enrollment™, drop=FALSE], groups=CTGdatai3tudy.S5tatus, statistics=c("mean"™, "sd", "IQR",
+ "quantiles"), quantiles=c(0,.25,.5,.75,1))
mean =d IOR 0% 25% 5S0% 75% 100% Enrollment:n
COCMPLETED 43.07143 55.10335 25.75 & 9.75 24,0 35.50 200 14
TEEMINATED 5.500C00 2.12132 1.50 4 4.7 5.5 ©.2% 7 2

YEARS

NIDDK




Orientation to Rcmdr GUI’s menus: Data—2> Summaries(2)

With Active Dataset, can do more customized summaries of interest:

* What if interested in different subset of enrollment summaries by status?
* TAKE ADVANTAGE OF R Script panel content: copy, edit, select & click

numSummary (CTGdata [, "Enrollment", drop=FALSE], groups=CTGdata$Study.Status,
statistics=c ("mean", "sd", "IQR", "quantiles"), quantiles=c(0,.25,.5,.75,1))

I numSummary (CTGdata [, "Enrollment", drop=FALSE], groups=CTGdataS$Study.Status,

statistics=c ("quantiles", "IQR" ), quantiles=c(0,.25,.5,.75,1))

m) ;. YYYYY ;
7950-203

NIDDK



Orientation to Rcmdr GUI’s menus: Data—2> Summaries(2)

With Active Dataset, can do more customized summaries of interest:

* What if interested in different subset of enrollment summaries by status?
* TAKE ADVANTAGE OF R Script panel content: copy, edit, select & click g Submit

numSummary (CTGdata [, "Enrollment", drop=FALSE], groups=CTGdata$Study.Status,
statistics=c ("mean", "sd", "IQR", "quantiles"), quantiles=c(0,.25,.5,.75,1))

I numSummary (CTGdata [, "Enrollment", drop=FALSE], groups=CTGdataS$Study.Status,

statistics=c ("quantiles", "IQR" ), quantiles=c(0,.25,.5,.75,1))

m) ;. YYYYY ;
7950-203

NIDDK



Orientation to Rcmdr GUI’s menus: Data—2> Summaries(2)

With Active Dataset, can do more customized summaries of interest:
* What if interested in different subset of enrollment summaries by status?
* TAKE ADVANTAGE OF R Script panel content: copy, edit, select & click s Submit

numSummary (CTGdata [, "Enrollment", drop=FALSE], groups=CTGdata$Study.Status, Can also ‘highlight’
statistics=c("mean", "sd", "IQR", "quantiles"), quantiles=c(0,.25,.5,.75,1)) line & use R-gui-
numSummary (CTGdata [, "Enrollment", drop=FALSE], groups=CTGdata$Study.Status,shortcut of ‘Ctrl+R’
statistics=c ("quantiles", "IQR" ), quantiles=c(0,.25,.5,.75,1)) to submit

m) ;. YYYYY ;
7950-203

NIDDK



Orientation to Rcmdr GUI’s menus: Data—2> Summaries(2)

With Active Dataset, can do more customized summaries of interest:

* What if interested in different subset of enrollment summaries by status?
 TAKE ADVANTAGE OF R Script panel content: copy, edit, select & click wG Submit

numSummary (CTGdata [, "Enrollment", drop=FALSE], groups=CTGdata$Study.Status, Can also ‘highlight’
statistics=c ("mean", "sd", "IQR", "quantiles"), quantiles=c(0,.25,.5,.75,1))

line & use R-qui-

numSummary (CTGdata [, "Enrollment", drop=FALSE], groups=CTGdata$Study.Status,shortcut of ‘Ctrl+R’
statistics=c ("quantiles", "IQR" ), quantiles=c(0,.25,.5,.75,1)) to submit

So menus provide starting code, thus you can customize \ per R function

m) 7

NIDDK



Orientation to Rcmdr GUI’s menus: Data—2> Summaries(2)

With Active Dataset, can do more customized summaries of interest:
* What if interested in different subset of enrollment summaries by status?
* TAKE ADVANTAGE OF R Script panel content: copy, edit, select & click s Submit

numSummary (CTGdata [, "Enrollment", drop=FALSE], groups=CTGdata$Study.Status, Can also ‘highlight’
statistics=c ("mean", "sd", "IQR", "quantiles"), quantiles=c(0,.25,.5,.75,1)) line & use R-gui-
numSummary (CTGdata [, "Enrollment", drop=FALSE], groups=CTGdata$Study.Status,shortcut of ‘Ctrl+R’
statistics=c ("quantiles", "IQR" ), quantiles=c(0,.25,.5,.75,1)) to submit
So menus provide starting code, thus you can customize \ per R function
> numSummary (CTGdata[, "Enrollment", drop=FALSE], groups=CTGdata$Study.Status, statistics=c("guantiles", "IQR" ),
IQR 0% 25% 50% 75% 100% Enrollment:n
COMPLETED 25.75 S5 9.75 24.0 35.50 200 14
TERMINATED 1.50 4 4.75 5.5 6.25 7 4

Same possibility to create new vars, like time since earliest CTG start

m) ;. YYYYY ;
7950-203

NIDDK



Orientation to Rcmdr GUI’s menus: Data—2> Summaries(2)

With Active Dataset, can do more customized summaries of interest:
What if interested in different subset of enrollment summaries by status?
* TAKE ADVANTAGE OF R Script panel content: copy, edit, select & click s Submit

numSummary (CTGdata [, "Enrollment", drop=FALSE], groups=CTGdata$Study.Status, Can also ‘highlight’
statistics=c("mean", "sd", "IQR", "quantiles"), quantiles=c(0,.25,.5,.75,1)) line & use R-gui-
numSummary (CTGdata [, "Enrollment", drop=FALSE], groups=CTGdata$Study.Status,shortcut of ‘Ctrl+R’
statistics=c ("quantiles", "IQR" ), quantiles=c(0,.25,.5,.75,1)) to submit

So menus provide starting code, thus you can customize \ per R function

> numSummary (CTGdata[, "Enrollment", drop=FALSE], groups=CTGdata$Study.Status, statistics=c("guantiles", "IQR" ),
IQR 0% 25% 50% 75% 100% Enrollment:n
COMPLETED 25.75 5 9.75 24.0 35.50 200

TERMINATED 1.50 4 4.75 5.5 6.25 7 4
Same possibility to create new vars, like time since earliest CTG start
> numSummary (CTGdata [, "DaysSinceEarliestStart", drop=FALSE], statistics=c("mean"”, "sd", "IQR", "quantiles"),
+ quantiles=c(0,.25,.5,.75,1))
mean sd IQR 0% 25% 50% 75% 100% n NA

1201 990.5105 1237 O 511 982 1748 3024 8 8

> numSunmmary (CTGdata[, "DaysSinceEarliestStart", drop=FALSE], groups=CTGdata$Study.Status, statistics=c("mean", "sd",
+ "IQR", "quantiles"), quantiles=c(0,.25,.5,.75,1))

mean sd IQR 0% 25% 50% 75% 100% DaysSinceEarliestStart:n DaysSinceEarliestStart:NA
COMPLETED 1268.429 1049.855 1346 0 482 1235 1828 3024 7 7

TERMINATED 729.000 NA 0 729 729 729 729 729 1 1




Orientation to Rcmdr GUI’s menus: Data—=> Summaries(2)

With Active Dataset, can do more customized summaries of interest:

* What if interested in different subset of enrollment summaries by status?
 TAKE ADVANTAGE OF R Script panel content: copy, edit, select & click ni;f,g, Submit

numSummary (CTGdatal[, "Enrollment", drop=FALSE], groups=CTGdata$Study.Status,
statistics=c ("mean", "sd", "IQR", "quantiles"), quantiles=c(0,.25,.5,.75,1))

Can also ‘highlight’

line & use R-qgui-

numSummary (CTGdatal[, "Enrollment", drop=FALSE], groups=CTGdata$Study.Status,shortcut of ‘Ctrl+R’
statistics=c ("quantiles", "IQR" ), quantiles=c(0,.25,.5,.75,1)) to submit

So menus provide starting code, thus you can customize \ per R function

> numSummary (CTGdata[, "Enrollment™, drop=FALSE], groups=CTGdatas5tudy.S5tatus, statistics=c("guantiles™, "IQR"™ ),
IOR 0% 25% 50% T5% 100% Enrollment:n

COMPLETED 25.75 5 9.75 24.0 35.50 200 14
TEEMINATED 1.50 4 4.75 5.3 ©6.25 7 ﬂ
Study. Status
ithils / / / / o COMPLETED & TERMINATED
Same possibility to create new vars, like time since earliest CTG start
> numSummary (CTGdata[, "DaysSinceEarliestStart™, drop=FALSE], statistics=c("mean", "sd", "IQR", "gquantiles"), 7
+ quantiles=c (0, .25,.5,.75,1}) a7
mean sd IQR 0% 25% 50% 75% 100% n NA = |
1201 990.5105 1237 O 511 982 1748 3024 8 8 £ L |
ng-l ()
> numSummary (CTGdata[, "DaysSinceEarliestStart™, drop=FALSE), groups=CIGdata$Study.Status, statistics=c("mean", "sd" N
+ "IQR", "quantiles"), quantiles=c(0,.25,.5,.75,1)) 2
mean sd IQR ©O% 25% 50% 75% 100% DaysSinceEarliestStart:n DaysSinceEarliestStart:NA 0 - A

COMPLETED 1268.429 1049.855 1346 0 482 1235 1828 3024 7 7 T T T T T T T
TERMINATED 729.000 NA 0 729 729 729 729 728 1 1 0 500 1000 1500 2000 2500 3000

DaysSinceEarliestStart



Orientation to Rcmdr GUI's menus: Summaries (1)

Edit Data Statistics Graphs

* Don’t forget that you can save your R data 2 ...

Open R Markdown file...

Save R Markdown file as...




Orientation to Rcmdr GUI’'s menus: Summatries (1)

* Don’t forget that you can save your R data 2>

R R Commander

File Edit Data Statistics Graphs

Change working directory...

Open script file...
Save script...
Save scr ipt as...

Open R Markdown file...
Save R Markdown file...
ave R Markdown file as...

ave output...

S
S
Save output as...
S

ave R workspace...

S

|

Exit

b

Messages

I[lé] NOTIE: R workspace saved to C:/Users/wilkinskj/OneDrive

During a later Rcmdr session
you can change your working
directory back to current one,
then use “Data > Load data
set...” menu option & its code:

> load({"ctg-studies_data-explore.Rdata")




Orientation to Rcmdr GUI's menus: Summaries (1)

R R Comman der ‘R Numerical Summaries

File Edit Data Statistics Graphs

Data Statistics

* Don’t forget that you can save your R data 2 ..o | e

Change working directory...

Save script...

Save script as...

* Note that ‘Enroliment’ was only numerical s | sonnsen
variable/column in Active Dataset |

ave R Markdown file as...

ave output...

S
S
Save output as...
S

ave R workspace...

S : 1 & Help ® Reset ‘ o OK

Exit

Messages

|[16] NOTE: R workspace saved to C:/Users/wilkinskj/OneDrive

During a later Rcmdr session
you can change your working
directory back to current one,
then use “Data > Load data
set...” menu option & its code:

> load({"ctg-studies_data-explore.Rdata")

m) ;. YYYYY ;
7950-203

© NIDDK




Orientation to Rcmdr GUI’s menus: Summar

‘R R Comman der
File Edit Data Statistics

Change working directory...

* Don’t forget that you can save your R data =2 ...

Save script...
Save scr ipt as...

* Note that ‘Enrollment’ was only numerical o=

Save R Markdown file as...

variable/column in Active Dataset

Save output as...

Save R workspace...

* To explore summaries for >1 numerical variable, =

Graphs

umerica | Summaries

Data Statistics

Variables (pick one or more)

Enrollment a

Summarize by groups... |

Messages

! 1 @Help ”Reset ' J OK

NHBLI trial data for digoxin/digitalis ‘Dic’ treatment
available in BioLINCC for educational use (like ours!)

* We 1st show how to re-load a R workspace in Remdr
* As it was originally imported from SAS, has no factors

’[16] NOTE: R workspace saved to C:/Users/wilkinskj/OneDrive

During a later Rcmdr session
you can change your working
directory back to current one,
then use “Data > Load data
set...” menu option & its code:

> load({"ctg-studies_data-explore.Rdata")

m) ;' YYYYY ;
Z
950-203°

NIDDK




Orientation to Rcemdr GUI’s menus: Summarles (1)

R R Comman der | R MNumerncal Summaries

File Edit Data Statistics Graphs
Change working directory...

* Don’t forget that you can save your R data =2 o

Save script...
Save script as...

* Note that ‘Enrollment” was only numerical oo ==
variable/column in Active Dataset

* To explore summaries for >1 numerical variable,

Data Statistics

Wariables (pick one or more)

ave R Markdown file as...

5

Save output...
Save cutput as...
5

ave R workspace...

1 & Help 4 Reset o 0K

NHBLI trial data for digoxin/digitalis ‘DI’ treatment | /e « s s o e s
available in BioLINCC for educational use (like ours!) During a later Remdr session
. you can change your working
* We 1st show how to re-load a R Workspace in Remdr directory back to current one,

then use “Data > Load data

e As it was originally imported from SAS, has no factors_l set..” menu option & its code:

> load("ctg-studies data-explore.Rdata")

ERROR: There are no factors in the active data set.

If we create new factors: DIG ‘group’ summaries work NIDDK ZS




Orientation to Rcmdr GUI’'s menus: Summaries (2)

Same ‘File’ has option to load workspace from

* Best Practice: ‘re-load’ prior-saved R data =2 Liior Remar session IF it's in your current

working directory via menu “Data > Load data

8 R Commander

set...” option (& its code): AT m———

” 1 ” N
> load("DIG-trial data-explore.Rdata") @ 02 ey




Orientation to Rcmdr GUI’'s menus: Summaries (2)

* Best Practice: ‘re-load’ prior-saved R data 2

* Working with ‘DIG” offers more numerical

variables/columns: 15t set as Active Dataset
e Then get names of variables in Active dataset =2 e

> names (DIGdata)

(L] "ID" "TRTIMI"
[11) "CREAT" "DIGDOSER"
[21] "PULCONG" "NSYM"
[31) "HYPERTEN" "DIGUSE"

ﬁjii

"AGE"
"CHFDUR"
"HEARTRTE"
"DIURETK"

" RACE ”
"RALES"
"DIABP"
"DIURET"

"SEX"
"ELEVJVP"
"SYSBP"
"KSUPP"

"EJF_PER"
"PEDEMA"
"FUNCTCLS"
"ACEINHIB"

"EJFMETH"
"RESTDYS"
"CHFETIOL"
"NITRATES"

"CHESTX"
"EXERTDYS"
"PREVMI"
"HYDRAL"

"BMI"
"ACTLIMIT"
"ANGINA"
"VASOD"

"DIABETES"
"DIGDOSE"

Same ‘File’ has option to load workspace from
prior Remdr session IF it’s in your current
working directory via menu “Data > Load data

144 . 0 . & RCommander
set...” option (& its code): TR C———T——
> load("DIG-trial data-explore.Rdata") e

o
RO pyreporre
= Al e =d Merne data cotc
it R Commander

File Edit Data Satistics Graphs Modes Dotibutions Tooks Help

@ oa New data set-.. 'Viewdataset Modek I <Noactne mode>
load data set...

no:nlx‘ Data in packages » [g~, daca=DIGdata )
suT=ATY }sie View data,
|°“§f;="" Manage varisbles in active dataset  » | Select active data set.—
"KLEVEL®" numSusmary (DIGdatalf, "WHF"®, drop=FALSE Refresh active data set
1))
ng3n ‘

Select row(s) from acbve data set-..
- readSAS ("C:/Usexs/wilkinsk)/OneD: Rernove row(s) from active data set...
STIiNgSASFAcTtors=IRUE, rownames=  Siack vanables in active data set.—

7
950-203°



Orientation to Rcmdr GUI’'s menus: Summaries (2)

* Best Practice: ‘re-load’ prior-saved R data 2
* Working with ‘DIG” offers more numerical

variables/columns; 15t set as Active Dataset
* Then get names of variables in Active dataset =2

> names (DIGdata)

(L] "ID" "TRTMI" "AGE" "RACE" "SEX" "EJF_PER" "EJFMETH" "CHESTX" "BMI"
[11) "CREAT" "DIGDOSER" "CHFDUR" "RALES" "ELEVJVP" "PEDEMA" "RESTDYS" "EXERTDYS" "ACTLIMIT" "
[21] "PULCONG" "NSYM" "HEARTRTE" "DIABP" "SYSBp" "FUNCTICLS" "CHFETIOL" "PREVMI" "ANGINA"
(31) "HYPERTEN" "DIGUSE" "DIURETK" "DIURET" "KSUpp" "ACEINHIB" "NITRATES" "HYDRAL" "VASOD"

Same ‘File’ has option to load workspace from
prior Remdr session IF it’s in your current

working directory via menu “Data > Load data
set...” option (& its code):

> load("DIG-trial data-explore.Rdata")

3 ats Stabstcs Graphs Models  Distnibytions

Grapl Modds Ootibutions Tooks Help

"DIABETES"
DIGDOSE"

Select row(s) from actve data set-..

* Can use “Ctrl-click” to select a number of related vars
* We do so (next slide) to check correlations among set

neD= Remove row(s) from active data set...
wnames®  Spack vanables in active data set.

i [

NIDDK

7950-203



Orientation to Rcmdr GUI’'s menus: Summaries (2)

: . Same “File’ h tion to load work i
) BeSt Practlce lre_loadl prlor-SOVEd R dOtG? ame °‘rile’ has option to load workspace from

prior Remdr session IF it’s in your current
working directory via menu “Data > Load data

* Working with ‘DIG” offers more numerical  set.” option (& its code):

variables/columns: 15t set as Active Dataset
* Then get names of variables in Active dataset =

> names (DIGdata)

(L) "ID" "TRTMI" "AGE" "RACE" "SEX" "EJF_PER" "EJFMETH" "CHESTX" "BMI"

"KLEVEL"
[11) "CREAT" "DIGDOSER" "CHFDUR" "RALES" "ELEVJVP" "PEDEMA" "RESTDYS"™ "EXERTDYS" "ACTLIMIT" "S3"
[21]) "PULCONG" "NSYM" "HEARTRTE" "DIABP" "SYSBp" "FUNCTICLS" "CHFETIOL" "PREVMI" "ANGINA" "DIABETES"
(31) "HYPERTEN" "DIGUSE" "DIURETK" "DIURET" "KSUpp" "ACEINHIB" "NITRATES" "HYDRAL" "VASOD" "DIGDOSE"

* Can use “Ctrl-click” to select a number of related vars
* We do so (next slide) to check correlations among set
DIG data can be assessed for “regression readiness”, too!

& R Commander

> load("DIG-trial data-explore.Rdata")

istics  Grap Modes DOotibutions Tooks Help

R R Commander

3 ats Stabstcs Graphs Models  Distnbytions

data set..
(ﬁ D
3 Load data set..

View dataset  Modet: I <No actne modd>

Select active data tet..

aaaaaaaa

resh active data s
Help on active data set (f svailable)

Sort actve data set...

Select row(s) from actwe data set...
Rernove row(s) from active data set...
wnames®  Spack vanables in active data set.




Orientation to Rcmdr GUI’'s menus: Summaries (2)

' : Same ‘File’ has option to load work :
* Best Practice: ‘re-load’ prior-saved R dat@ = yrior remar session IF it's in your current

prior Remdr session IF it’s in your current
working directory via menu “Data > Load data

® Working W|th IDIG’ OfferS more numeriC(J/ set...” option (& its code): e

File Edit Data Stabsbics Graphs Model:  Distnbytions

> load("DIG-trial data-explore.Rdata") R ° guywrm

variables/columns; 15t set as Active Dataset

File Edit Data Statistics Graphs Modds Ootibutions Tooks Help

@ Oa N““ :t Viewdataset Modek I <No actne modd>
. . e R S¢rp J Mcrg ets...

* Th t names of bl Active dataset 2 oy |
en e na eS O Va rla es In C Iv a ase normal 3 Dm packages ’}:- aaaaaaaaaaa )

suT=ATY bon of View data...
> names (DIGdaca) | ﬁ;’. Mu\agc aiables in active data set ’, Select active data set..
(1) "1D" "TRIMI" "AGE" "RACE" "SEX" "EJF_PER" "EJEMETH" "CHESTX"  "BMI" "KLEVEL" munSusmary (DIGdacal, “WHE", dropeFALSE, Reh steduase

[11) "CREAT" "DIGDOSER" "CHFDUR" "RALES" "ELEVJVP" "PEDEMA" "RESTDYS" "EXERTDYS" "ACTLIMIT" "S3" ‘ v 1abies in
[21] "PULCONG" "NSYM" "HEARTRTE" "DIABP" "SYSBP" "FUNCTCLS" "CHFETIOL" "PREVMI" "ANGINA" "DIABETES" Subze( R

[31) "HYPERTEN" "DIGUSE" "DIURETK" "DIURET" "KSUPP" "ACEINHIB" "NITRATES"™ "HYDRAL" "VASOD" "DIGDOSE" F A B A

* Can use “Ctrl-click” to select a number of related vars T
* We do so (next slide) to check correlations among set
DIG data can be assessed for “regression readiness”, too!

STringsAsFactors=TRUE, rownames=  Gack vanabkes in active data set.
Output

| |> summary(powerTransform(cbind(BMI, CREAT, DIABP, SYSBP) ~ 1, data=DIGdata, family="bcnPower™))
bcnPower transformation to Multinormality

Estimated power, lanbda
Est Power Rounded Pwr Wald Lwr Bnd Wald Upr Bnd
BMI -0.6490 -0.649 -0.7583 -0.5398
CREAT -1.0379 -1.000 -1.1300 -0.9458
DIABP 0.2261 0 33 0.0921 0.3600
2{00)

SYSBP -0.1€47 -0.3159 -0.0536




Orientation to Rcmdr GUI’'s menus: Summaries (2)

' : Same ‘File’ has option to load work :
* Best Practice: ‘re-load’ prior-saved R dat@ = yrior remar session IF it's in your current

prior Rcemdr session IF it’s in your current
working directory via menu “Data > Load data

° WOrking W|th IDIG’ OfferS maore numel’iCG/ set...” option (& its code): T

File Edit Data Statstcs Graphs Models Distnbytions

> load("DIG-trial data-explore.Rdata") R o Nda ) set
variables/columns; 15t set as Active Dataset
) - file €dit Data Statistics Graphs Models Dstibutions Took Help
@ O I_N:::i‘::l:: Viewdataset  Modet: I <Noa<tne model>
. . e R Scrpt RJ Merge data sets...
- Then get names of variables in Active dataset = S b
e n ge n a eS O Va rI a eS I n C lv a a Se no:lai; Dm:p::hgs L }:-, x:a-g; aaaa ;_
suT=ATY Al sie o View data...
> names(DIGdata) |“§f;‘=’ Manage vaciables in active data st » Select active data set..
(L) "ID" "TRTMI" "AGE" "RACE" "SEX" "EJF_PER" "EJFMETH" "CHESTX" "BMI" "KLEVEL" numSummary (DIGdataf, "NHE", drop=FALSE| Rofreshactivedata set
[11] "CREAT" "DIGDOSER" "CHFDUR" "RALES" "ELEVJVP" "PEDEMA" "RESTDYS" "EXERTDYS" "ACTLIMIT" "S3" ‘ v Vanab
[21] "PULCONG" "NSYM" "HEARTRTE" "DIABP" "SYSBP" "FUNCTCLS" "CHFETIOL" "PREVMI" "ANGINA" "DIABETES" &;“ p
[31]) "HYPERTEN" "DIGUSE" "DIURETK" "DIURET" "KSUPP" "ACEINHIB" "NITRATES"™ "HYDRAL" "VASOD" "DIGDOSE" M,c;v:,mmf
“Ctrl-click” | mb f related
[ ] A o Select row(s) from active data set...
Can use “Ctrl-click™ to select a number of related vars e e
. string gSAsFactors=IRUE, & e vai n 3ctrve data set.—

* We do so (next slide) to check correlations among set
DIG data can be assessed for “regression readiness”, too!

- Output R Compute New Variable X

Current vaiiables (double-click to expression)
ACEINHIB

| |> summary (powerlransform(cbind(BMI, CREAT, DIABP, SYSBP) ~ 1, data=DIGdata, family="bcnPower™)) ACTUMIT [
bcnPower transformation to Multinormality AGE

ANGINA

Estimated power, lambda CHESTX

Est Power Rounded Pwr Wald Lwr Bnd Wald Upr Bnd Biewyaciable mame Expissaian o compise
BMI -0.6490 -0.649 -0.7583 -0.5398 Ll Ll

CREAT  -1.0379 -1.000 -1.1300 -0.9458

DIABP  0.2261 0.330— 0.0921 0.3600

@Heﬁp ” Reset [ J (414 J x Concel ”Mp‘y
SYSBP -0.1847 -O.lﬂ‘[:]ﬂ/'l -0.3159% -0.0536
| \\.‘.,



Orientation to Rcmdr GUI’s menus: Summaries (2)

Same ‘File’ has option to load workspace from

* Best Practice: ‘re-load’ prior-saved R data = ,:ior remdr session IF it's in your current

working directory via menu “Data > Load data

* Working with ‘DIG” offers more numerical  set.” option (8. its code): =

File Edit Data Statistics Graphs Models Distributions

> load("DIG-trial data-explore.Rdata") R 0= Ndmm’” set

variables/columns; 15t set as Active Dataset

File Edit Data Statistics Graphs Models Distributions Tools Help

. New data set..
R o i View dataset  Model: | 3 <MNo active model>
Load data set...

RScript g|  Merge data sets..

* Then get names of variables in Active dataset = b

normali|  Datain packages ", data=DIGdata)

susa [ RAP SY i dts..
> names (DIGdata)

- Manage variables in active data set » Select active data set...
(11 “Igr "TRTMT" "AGE" "RACE" "SEX" "EJF PER" "EJFMETH" "CHESTX" "BMI" "KLEVEL" nSmmary (Diadacal, "WHE", drop-FALSE 2","‘"’2‘?‘?’3“;(“ b
[11] "CREAT" "DIGDOSER"™ "CHFDUR" "RALES" "ELEVJVP" "PEDEMA™ "RESTDYS" "EXERTDYS" "ACTLIMIT" "S3" o o —

[21] T"PULCONG"™ "NSYM" "HEARTRTE" "DIABP" "SYSBP" "FUNCICLS"™ "CHFETIOL"™ "PREVMI" "ANGINA™ "DIABETES"
[31] "HYPERTEN" "DIGUSE" "DIURETK"™ "DIURET" "KSUPP" "ACEINHIB" "NITRATES"™ "HYDRAL" "VASOD" "DIGDOSE"™

Set case names...
Subset active data set...
Sort active data set...

ll e ” ST Aggregate variables in active data set
. - > DIGdata <- Select row(s) from active data set...
+ readSAS ("C:/Users/wilkinskj/OneDy Remove row(s) from active data set...
+ stringsAsFactors=TRUE, rownamess Stack variables in active data set...
L] L]
 We do so (next slide) to check correlations damong set
DIG dat b d for “ ' di ” too!
dla Can be assessed 10r regression reaainess , too:
: Output ‘.} Compute New Variable XV | [§gcomeutcilionanbic x|
‘ [ | Current variables (double-click to expression) | Cusvent vasiables (double-click to expression)
] [ACEINHIB BACEINHIB
| |> summary(powerTransform(cbind (BMI, CREAT, DIABP, SYSBP) ~ 1, data=DIGdata, family="bcnPowez")) | acTum | | ﬁgE‘M'T |
| |bcnPower transformation to Multinormality | ﬁ:EINA | [aNGINA
“ BARINEECH. DowcE,. 230ha = i:is\z(riahle name Expression to compute | :J':\?::nahle name Expression to compute
| Est Power Rounded Pwr Wald Lwr Bnd Wald Upr Bnd | ey s BMI_benPower bePower (BMI, lambda=—0.&45)
| |BMI -0.6490 -0.64%9 -0.7583 -0.5398 | - | YEARS
CREAT -1.000 -1.1300 -0.9458 2 e — .
‘ DIABP 0.330 0.0821 0.3600 | Brep 4 Reset o oK 9 Concel | P Apply | @rer 9 Reset o oK & cancel | P Apply
| |SYSBP -0.185 -0.315% -0.0536 |

7950_502°




Orientation to Rcmdr GUI’s menus: Summaries (3)

Change Active Dataset, to DIG trial data (by import of NHLBI’s SAS file)

‘bivariate’ data summaries under menus now available for >1 continuous vars




Orientation to Rcmdr GUI’s menus: Summaries (3)

Change Active Dataset, to DIG trial data (by import of NHLBI’s SAS file)

‘bivariate’ data summaries under menus now available for >1 continuous vars

@R R Commande

m) ;. YYYYY ;
7950-203

NIDDK



Orientation to Rcmdr GUI’s menus: Summaries (3)

Change Active Dataset, to DIG trial data (by import of NHLBI’s SAS file)

’blvarlate data summaries under menus now available for >1 continuous vars
( to select non-adjacent vars in list, use Ctrl+click as you add )




Orientation to Rcmdr GUI’s menus: Summaries (3)

Change Active Dataset, to DIG trial data (by import of NHLBI’s SAS file)

‘bivariate’ data summaries under menus now available for >1 continuous vars

@R R Commander

e ( to select non-adjacent vars in list, use Ctrl+click as you add )

-

Contingency tables ’ Numerical summaries...
RScrpt RMar LIIE >
CEmSE Proportions » Count missing observations
»
»

strings. Vanances

library (Hmi Nonparametnc tests
rcorr. 533“5 Dimensional analysis Comrelation test...
rcorr.adjus Fit models » Test of normality...
scatterplot

data=DIGdata) ) Transform toward normality...

Correlation matrix...

A Conelrion Mabru

Vanables (D4 k two 0r moie)
ACEHE

Vasebies (Pxk tao 0f move)

KY00AYS

OEATY |
THDAY

NIDDK 75

Z
950-203°



Orientation to Rcmdr GUI’s menus: Summaries (3)

Change Active Dataset, to DIG trial data (by import of NHLBI’s SAS file)

‘bivariate’ data summaries under menus now available for >1 continuous vars

@R R Comman der

o ( to select non-adjacent vars in list, use Ctrl+click as you add )

RScnpt RMark Means

[ for illustration we select pairwise-complete Pearson’s with p-values ]

Pairwise two-sided
BMI CREAT
BMI
CREAT 0.2255
DIABP 0.9656
SYSBP 0.709

Ad;




Orientation to Rcmdr GUI’s menus: Summaries (3)

Change Active Dataset, to DIG trial data (by import of NHLBI’s SAS file)

‘bivariate’ data summaries under menus now available for >1 continuous vars

@R R Commander

o e e o (0 S@lECE NON-adjacent vars in list, use Ctrl+click as you add )

Summari es » Active data set

LR DAt set B Continigericytables’ ]| | Numeriéal summbries
e e 1 anmeses | for illustration we select pairwise-complete Pearson’s with p-values ]
library (Hmt
= / S - |
scacterplort W Transform toward nomalitys, | = Pairwlise two-sided p-values:
e . rcorr.adjust (DIGdata[,c ("BMI", "CREAT", "DIABP"," BMI CREAT DIABP SYSBP
: YSBP") ], type="pearson", BMI 0.2255 0.9656 0.7096
use="palrwise.complete") CREAT 0.2255 0.2842 0.4424
DIABP 0.9656 0.2842 0.4053
Pearson correlations: SYSBP 0.7096 0.4424 0.4053
BMI CREAT DIABP SYSBP
BMI 1.0000 -0.0147 0.0005 0.0045 Adjusted p-values (Holm's method)
CREAT -0.0147 1.0000 -0.0130 -0.0093 BMI CREAT DIABP SYSBP
DIABP 0.0005 -0.0130 1.0000 0.0101 BMI 1 1 1
SYSBP 0.0045 -0.0093 0.0101 1.0000 CREAT 1 1 1
DIABP 1 1 1
Number of observations: SYSBP 1 1 1

BMI CREAT DIABP SYSBP
BMI 6799 6799 6794 6796
CREAT 6799 6800 6795 6797
DIABP 6794 6795 6795 6792
SYSBP 6796 6797 6792 6797

W 7

NIDDK




Orientation to Rcmdr GUI’s menus: Summaries (3)

Change Active Dataset, to DIG trial data (by import of NHLBI’s SAS file)

‘bivariate’ data summaries under menus now available for >1 continuous vars

@R R Commander

e e s s oo (80 S@lECt NON-adjacent vars in list, use Ctrl+click as you add )

Summari es » Active data set

LR Dot set e Contngenicy tables  ¥]| | Numeriéal summiariesl,
e e 3 anmses | for illustration we select pairwise-complete Pearson’s with p-values ]
library (Bmi Nonparametric tests  * | IEEITITOR P TEN
= / e . .
scacterplost W Transform toward normality.. | > Pairwise two-sided p-values:
= x rcorr.adjust (DIGdatal[,c("BMI", "CREAT", "DIABP", " BMI CREAT DIABP SYSBP
YSBP")], type="pearson", BMI 0.2255 0.9656 0.7096
use="palrwise.complete") CREAT 0.2255 0.2842 0.4424
DIABP 0.9656 0.2842 0.4053
Pearson correlations: SYSBP 0.7096 0.4424 0.4053
BMI ~ CREAT DIABP  SYSBP
BMI 1.0000 -0.0147 0.0005 0.0045 Adjusted p-values (Holm's method)
CREAT -0.0147 1.0000 -0.0130 -0.0093 BMI CREAT DIABP SYSBP
DIABP 0.0005 -0.0130 1.0000 0.0101 BMI 1 1 1
SYSBP 0.0045 -0.0093 0.0101 1.0000 CREAT 1 1 1
DIABP 1 1 1
Number of observations: SYSBP 1 1 1
BMI CREAT DIABP SYSBP ‘"~ :
BMI 6799 6799 6794 6796 ik

CREAT 6799 6800 6795 6797  dfwmm
DIABP 6794 6795 6795 6792 s soemmom m)
© Pearson product- moment  ©Q Two-sded
SYSBP 6796 6797 6792 6797 Ommmer otwws Sy [

B e @ Reset J o R Conced @ Apply N ' D D K 79502032




Orientation to Rcmdr GUI’s menus: Summaries (3)

Change Active Dataset, to DIG trial data (by import of NHLBI’s SAS file)

‘bivariate’ data summaries under menus now available for >1 continuous vars

@R R Commander o . o o
e e s s oo (80 S@lECt NON-adjacent vars in list, use Ctrl+click as you add )
R ik Contingency tables 4 Numencal summaries...
npt arkda  Means » ° . . 5 ) .
e e amesess | for illustration we select pairwise-complete Pearson’s with p-values |
lxb:a:yr::;i N:mp:r:metnc tests
iR ‘:3\‘:: Qnmensional analysis Correlation test...
’ﬁﬁzéﬁtijﬁ’?"d'121:3&3“““- > Pairwise two-sided p-values:
— . - rcorr.adjust (DIGdata[,c("BMI", "CREAT", "DIABP", " BMI CREAT DIABP SYSBP
, YSBP")], type="pearson", BMI 0.2255 0.9656 0.7096
use="palrwise.complete") CREAT 0.2255 0.2842 0.4424
DIABP 0.9656 0.2842 0.4053
Pearson correlations: SYSBP 0.7096 0.4424 0.4053
BMI CREAT DIABP SYSBP
BMI 1.0000 -0.0147 0.0005 0.0045 Adjusted p-values (Holm's method)
CREAT -0.0147 1.0000 -0.0130 -0.0093 BMI CREAT DIABP SYSBP
DIABP 0.0005 -0.0130 1.0000 0.0101 BMI 1 1 1
SYSBP 0.0045 -0.0093 0.0101 1.0000 CREAT 1 1 1
DIABP 1 1 1
Number of observations: SYSBP 1 1 1
BMI CREAT DIABP SYSBP *““=* -

BMI 6799 6799 6794 6796 Gin |

| CHFEOL

CREAT 6799 6800 6795 6797 s

CREV

DIABP 6794 6795 6795 6792  uucomin Anenae Wypothesn

W 7

| R |6 NIDDK

SYSBP 6796 6797 6792 6797 ‘?§§$$”°§§ag
& rep 4 Reset | oK



Orientation to Rcmdr GUI’s menus: Summaries (3)

Change Active Dataset, to DIG trial data (by import of NHLBI’s SAS file)

‘bivariate’ data summaries under menus now available for >1 continuous vars

@R R Commander

e e s s oo (80 S@lECt NON-adjacent vars in list, use Ctrl+click as you add )

Summari es » Active data set

R Dotaset Contingency tables > Numerncal summaries...
e e 1 anmsees | | for illustration we select pairwise-complete Pearson’s with p-values |
library(Hmt Nonparametric tests
“core aa3uas / S . .
scactarplon & Transform toward nommalitys, | = Pairwise two-sided p-values:
- . rcorr.adjust (DIGdata[,c("BMI", "CREAT", "DIABP", " BMI CREAT DIABP SYSBP
YSBP")], type="pearson", BMI 0.2255 0.9656 0.7096
use="palrwise.complete") CREAT 0.2255 0.2842 0.4424
DIABP 0.9656 0.2842 0.4053
Pearson correlations: SYSBP 0.7096 0.4424 0.4053
BMI CREAT DIABP SYSBP
BMI 1.0000 -0.0147 0.0005 0.0045 Adjusted p-values (Holm's method)
CREAT -0.0147 1.0000 -0.0130 -0.0093 BMI CREAT DIABP SYSBP
DIABP 0.0005 -0.0130 1.0000 0.0101 BMI 1 1 1
SYSBp 0.0045 -0.0093 0.0101 1.0000 CREAT 1 1 1
DIABP 1 1 1
Number of observations: SYSBP 1 1 1
BMI CREAT DIABP SYSBP "=~ "

AT_bcnPowez, alternative="two.sided”

BMI 6799 6799 6794 6796 Gin |

‘LHHHm

CREAT 6799 6800 6795 6797 snumwes

CREV

DIABP 6794 6795 6795 6792  uucomin Anenae Wypothesn

rrelation

W /5

SYSBP 6796 6797 6792 6797 °»j:“13"‘“ °“§"
& Hep 4 Reset o Kk | 3 conce N'DDK 79502032



Orientation to Rcmdr GUI’s menus: Summaries (3)

Change Active Dataset, to DIG trial data (by import of NHLBI’s SAS file)
‘bivariate’ data summaries under menus now available for >1 continuous vars

L — ( to select non-adjacent vars in list, use Ctrl+click as you add )

Numerical summaries...

RScript RMarkdg ~ Means

e e aoeeens | fOr illustration we select pairwise-complete Pearson’s with p-values ]

Table of statistics...

[library(Hmis  Nonparametric tests [l  Correlation matrix...

| |Fcorr.adiust  pimensional analysis  *|  Correlation test..

| |[rcorr.adjust .
1 Test lity..
| |scatterpror Fit models est of normality.

| e 10 Recohm i e | Pairwise two-sided p-values:
rcorr.adjust (DIGdatal[,c ("BMI", "CREAT", "DIABP"," BMI CREAT DIABP SYSBP

YSBP")], type="pearson", BMI 0.2255 0.9656 0.7096

use="pairwise.complete") CREAT 0.2255 0.2842 0.4424

\\\\\\\\\
AAAAAAA

DIABP 0.9656 0.2842 0.4053
Pearson correlations: SYSBP 0.7096 0.4424 0.4053
BMI  CREAT DIABP  SYSBP
BMI 1.0000 -0.0147 0.0005 0.0045 Adjusted p-values (Holm's method)
CREAT -0.0147 1.0000 -0.0130 -0.0093 BMI CREAT DIABP SYSBP
DIABP 0.0005 -0.0130 1.0000 0.0101 BMI 1 1 1
SYSBP 0.0045 -0.0093 0.0101 1.0000 CREAT 1 1 1
DIABRP 1 1 1
Number of observations: SYSBP 1 1 1
BMI CREAT DIABP SYSBP ‘=™ X
BMT 67 9 9 67 9 9 67 94 67 9 6 : EEEE)?& | > w:.ti".tDI\-S:lata, Ic‘:‘r.teit(CF-Eél-', CREATTb-::Pcwwe:, alternative="two.sided"
craT 6795 6600 6795 677 e
' DIABP 6794 6795 6795 6792  sucrus  sviespons e s
(SYSBP 6796 6797 6792 6797 Cmmme Somme " S msemees
(@ b (T3] Kot O | jﬁ};“mw




Orientation to Rcemdr GUI’s menus: Graphics (1)

* For DIG Active Dataset, let’s
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g0 beyond bar plots & singl
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Orientation to Rcemdr GUI’s menus: Graphics (1)

* For DIG Active Dataset, let’s go beyond bar plots & single scatterplots

100 150 200

“In order to create an anonymous dataset that protects T
patient confidentiality, most variables have been permuted
over the set of patients within treatment group. Therefore,
this dataset can reproduce the results of the NEJM R s
paper; however, it would be inappropriate to use this — S—
dataset for other research or publication purposes. £ o
Multidimensional relationships, not included in the
NEJM, may not have been preserved during the
permutation process.” —THUS, lack of BPs’ correlation

o
=]

20 30 40 50 60

1 I
100 150

T
50

150 200
1 l

100
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Orientation to Rcmdr GUI’s menus: Graphics (1)

* For DIG Active Dataset let’s 80 beyond bar plots & single scatterplots

100 200

“In order to create an anonymous dataset that protects S s .o -
patient confidentiality, most variables have been permuted : o222
over the set of patients within treatment group. Therefore,
this dataset can reproduce the results of the NEJM
paper; however, it would be inappropriate to use this
dataset for other research or publication purposes.
Multidimensional relationships, not included in the
NEJM, may not have been preserved during the
permutation process.” —THUS, lack of BPs’ correlation

20 30 40 50 60

200
|

150
|




Orientation to Rcmdr GUI’s menus: Graphics (3)

‘eroup-based’ scatterplot matrices post-normality transformations

&

8 - E
| | 1 1 1

=] o o

N N | 8 ke

> with(DIGdata, cor.test (CREAT, CREAT bcnPower, alternative="two.sided"

| |
20
1
Pearson's product-moment correlation
" data: CREAT and CREAT bcnPower
1 1 0t = - — S, T R — -
t = 12 28 = §798, p-value < 2.2e-16
"=y alternati hesis: t elation is not equa o0
LK i)
- ) 95 e 1
III
,

Ii NEITTTE
=
.#”'@Mmm"o lce ve hypot ] rue correlat i o gual t©
E‘ per onfid erval:
o 0.8153180 0.8343505
-] sample estimates:
§_ - COor
d

l.\' = - - -
~.|0.826982

Does each distribution, by
treatment color, tend
toward one that’s more
unimodal & symmetric?

CREAT_bcnPower

2
]
- oo
- —
oo @0
n O = e o
1 ITT 1T A




Diabetes and Digestive
and Kidney Diseases

m) National Institute of Z5 From Rcmdr Orientation to Usable Data Steps:

OVERALL Take Home Objectives

| LR Question X

To exit, use File > Exit > options or ‘X’ on Rcmdr window O -
[ save script/workspace/output beforehand though] o [ )

|
|
|
_____ S

To summarize: couldn’t you now note that you’ve got traction on 1-2 items below?

You could, now if not after engaging hands-on per this webinar & others (listed online)
Ris For All, Part 1: R Commander to lower learning curves

» Loading Remdr, Orientation to its GUI Window’s panels/menus
» Importing Data, setting an Active Dataset, single datatrame curation
» Navigating menus & generating re-usable cocde: exploring Active data

e Take Home Objective: For beginners, know how to load R Commander,
import data, and navigate the GUI.


https://bioinformatics.ccr.cancer.gov/btep/classes/principles-of-data-collection-and-management
https://bioinformatics.ccr.cancer.gov/btep/classes/principles-of-data-collection-and-management

Questions? Comments? Other

“Data are meant to be used by All so, clearly, a freely
available & open-source software like R is for All.”

feedback or concerns?

{ sorme R originators’ s original take normes velow J

“The large and active community is a major strength,
contributing to its vast library of packages and ongoing
development.” — Robert Gentleman & Ross |haka [ R Bloggers ]

“We have named our language R—
in part to acknowledge the
influence of [ Bell Lab’s John
Chambers-originated language] S
and in part to celebrated our own
efforts.” — Robert Gentleman &
Ross lhaka [ R Documentation ]

“We wanted users to be able to begin in an interactive environment,
where they did not consciously think of themselves as programming.
Then as their needs became clearer and their sophistication
increased, they should be able to slide gradually into programming,
when language and system aspects would become more important.”
— Ross lhaka [ Medium ]

National Institute of
DlabeteS and DlgeStI\le of by typing potentially arcane
and Kidney Diseases

“R changed my opinion of humanity to some extent, to see
how people are really willing to freely give of themselves and
produce something larger than themselves without any
thought of personal glory.” — Ross lhaka [ History of Data Science ]

“[Rcmdr is designed for] providing
access to R statistical software through
familiar menus and dialog boxes instead

commands.” —John D. Fox [ R Commander
Textbook Preface ]

Oiner nelojul
resources Jlinks

WiItnin NIH SharePoint:

“Although it was originally
intended for use in basic statistics
classes, the current capabilities of
the R Commander...extend well
beyond basic statistics.” —John D.
Fox [ R Commander Textbook Preface ]




NIDDK

Additional Slides Follow for more details to
consider when you try Remdr on yr own time...

Other helpful
YEARS resources
/links within
NIH SharePoint:
: 8

Advancing Research & Health for All




Nuance with Rcemdr GUI’'s menu options: Data import (+1)

* FEW ISSUES using analytic platforms’ files: sas/stata /spss
* Again, ‘file’/‘worksheet’ becomes aR ‘data. frame’

@R Read Text Data From File, Clipboard, or URL

Enter name for data set: CTGdataI

WHEN importing

* Excel-able files: .csv (IF no CELLS or ENTRIES HAVE COMMAS NoT INSIDE “s
OR USE .xIsx (or character-delimited .txt files—IF NO cELLs or ENTRIES HAVE COMMAS )

X |

Variable names in file:
Convert character vanables to factors
Missing data indicator:

Location of Data File

O Local file system

O Clipboard

O Internet URL

Field Separator

O White space  © Commas ]

O Semicolons ;] O Tabs

O Other  Specify:
Decimal-Point Character

© Period [ ]
O Commal,)

@Help l JOK I xCanceI

,'@ Read Text Data From File, Clipboard, or URL

Enter name for data set: Dataset
Variable names in file: - ]

Convert character variables to factors
Missing data indicator: NA
Location of Data File

O Local file system

O Clipboard

O !nternet URL

Field Separator

O Whitespace (O Commas|,]

O Semicolons ;] O Tabs

O Other  Specify:

Decimal-Point Character

O Period [.]

O Commal)]

@Help | JOK | xCanceI

data, iISsues in some formats [ASWE SHOW WITH ORIGINAL .CSV FILE }

R Script R |

Data in packages

(R R Commander

New data set...

R >
Load data set...

Merge data sets...

Import data

Active data set
Manage varnables in active data set

File Edit Data Statistics Graphs Models Distributions Tools Help

E set View data

from text file, clip
from SPSS data se
from SAS xport fil
from SAS b7dat fi

* Designating ingest settings, becomes Active data

from Minitab dat
from STATA data

from Excel file...

V

{® R Commander

File Edit Data Statistics Graphs Models Distributions Tools Help

t set | View data set

[Simportaa

R >

R Script R |

New data set...
Load data set...
Merge data sets...

Data in packages
Active data set

Manage variables in active data set

\ 4

v v v

odel: | £ <No act

from text file, clipboard, or URL...
from SPSS data set...

from SAS xport file...

from SAS b7dat file...

from Minitab data set...

from STATA data set...

from Excel file...




Nuance with Remdr GUI’s menu options: Data import (+1)

WHEN importing data, issues in some formats [AS WESHOW WITH ORIGINAL .CSV FILE }

R R Commander

’ Excel-a b | e fi | eS: G5V (IF m CELLS or ENTRIES HAVE COMMAS M INSIDE ””S File Edit Data Statistics Graphs Models Distributions Toeols Help
OR USE .xIsx (or character-delimited .txt files—IF NO cEeLLS or ENTRIES HAVE COMMAS ) R 0 Newduaset.

t o) View dat
Load data set... rse ] View data

* FEW ISSUES using analytic platforms’ files: sas/stata /spss * " e

Data in packages

* Again, ‘file’/'worksheet’ becomes aR ‘data. frame’ i

* Designating ingest settings, becomes Active data

from text file, clip
from SPSS data se
from SAS xport fil
from SAS b7dat fi
from Minitab dat
from STATA data

from Excel file...

r

| “R' Read Text Data From File, Clipboard, or URL ® | | “R' Read Text Data From File, Clipboard, or URL = | R R Commander
Enter name for data set: CTGdata] _ Enter name for data set: Dataset File Edit Data Statistics Graphs Models Distributions Tools Help
\ellaziable nacass.in fils: ' Magiable names.in file: m ' [ '
_ = . : New data set... - .
{ Convert character variables to factors [ | | Convert character variables to factors (@ f RI Dai set Lol View data set odel: | £ <No act
Missing data indicator: Missing data indicator: NA Load data set...
Location of Data File Location of Data File R Script RI Merge data sets...
© Local file system © Local file system .
O Clipboard O Clipbeard Import data » from text file, clipboard, or URL...
e . O Internet URL . Data in packages »  from SPSS data set...
Field Separator Field Separator . .
~ . Activ » from SAS xport file...
(O) White space @ Commas[,] © Whitespace () Commas[,] ctive data set p
(O Semicolons ;] () Tabs () Semicolons[:] () Tabs Manage variables in active data set » from SAS b7dat file...
| O Other  Specify: ' O Other  Specify: from Minitab data set...
Decimal-Point Character ; Decimal-Point Character : from STATA data set
© Period [] © Period [.) . = -
() Commal,] () Commal,] rom Excel file...

@Help @r’ oK x Cancel @Help x Cancel



Nuance with Remdr GUI’s menu options: Data import (+1)

WHEN importing

¢ Excel-able files: .csv (IF NO CELLS or ENTRIES HAVE COMMAS NoT INSIDE “”s
OR USE .xIsx (or character-delimited .txt files—IF NO cEeLLS or ENTRIES HAVE COMMAS ) R o

data, issues in some formats [AsWESHOW WITH ORIGINAL .CSV FILE }

R R Commander

File Edit Data Statistics Graphs Models Distributions Toeols Help

MNew data set...

t o) View dat
Load data set... rse ] View data

Merge data sets...

R Script R|

* FEW ISSUES using analytic platforms’ files: sas/ stata /spss

Import data from text file, clip

Data in packages from SPSS data se

. iLe ? i /7 { 4 Active data set from SAS xport fi

¢ Aga I n’ fl | e / WO rkS h eet beco m es a R da t a. . f r ame Manage variables in active data set from SAS b7dat fi
from Minitab dat:

from STATA data

from Excel file...

* Designating ingest settings, becomes Active data

- a |
| “R' Read Text Data From File, Clipboard, or URL ® | | “R' Read Text Data From File, Clipboard, or URL = | R R Commander
Enter name for data set: CTGdata] _ Enter name for data set: Dataset File Edit Data Statistics Graphs Models Distributions Tools Help
\ellaziable nacass.in fils: ' Magiable names.in file: m [ '
_ = . N New data set... - .
j—Conyert chacacteryaniablesto factor | .—Convert character variables to factors R Ds set | View data set odel: | £ <No act
Missing data indicator: . Missing data indicator: NA Load data set...
e haa i ! : LR = AMarrm o ==
*2 R Script R| Merge data sets...
© Local file system © Local file system . . .
O Clipboard O Clipbeard Import data » from text file, clipboard, or URL...
O Intemnet URL © Intemet URL Data in packages » from SPSS data set...
Field Separator Field Separator . .
B b LY
O Whitespace  © Commas L] O Whitespace () Commas [ Active data set from SAS xport file
O Semicolons ;] O Tabs () Semicolons [;] O Tabs Manage variables in active data set » from SAS b7dat file...
| O Other  Specify: O Other  Specify: from Minitab data set...
Decimal-Point Character Decimal-Point Character : from STATA data set
© Period [] © Period [.) _ *
O Commal,] O Commal,] from Excel file...
@ Help x Cancel @ Help x Cancel



Nuance with Remdr GUI’'s menu options: Data import (+1)

WHEN importing data, issues in some formats [ASWESHOW WITH ORIGINAL .CSV FILE }

R R Commander

* Excel-able files: .csv (IF no CELLS or ENTRIES HAVE COMMAS NOT INSIDE “s o e oo 1o 1
OR USE .xlIsx (or character-delimited .txt files—IF NO CELLS or ENTRIES HAVE COMMAS ) N n e |

Load data set...

I set | | View data

RScript p|  Merge data sefs...

* FEW ISSUES using analytic platforms’ files: sas/stata/spss " mrerre—

Data in packages
Active data set

* Again, ‘file’/‘worksheet’ becomes aR ‘data. frame’ e e

from text file, clip
from SPSS data se
from SAS xport fi
from SAS b7dat fi
from Minitab dat,
from STATA data
from Excel file...

* Designating ingest settings, becomes Active data

[@ Read Text Data From File, Clipboard, or URL X | [® Read Text Data From File, Clipboard, or URL X | R R Commander
| Enter name for data set: CTGdata| Enter name for data set: Dataset File Edit Data Statistics Graphs Models Distributions Tools Help
. ‘ | New data set... .
—Conuert charactervariahlecto factorc I LConyert charactervariables to factors 8 R Dal set | View data set
Missing data indicator: Missing data indicator: NA Load data set...
Ewestionof-Bote-Fik bosstion-of-Date-sile RScript R| Merge data sets...
© Local file system © Local file system ) = _
O Clipboard () Clipboard [ Import data b from text file, clipboard, or URL...
O Internet URL | () Internet URL , Data in packages K from 5PS5 data set...
p—Frei-Separaror Fretd-beporator " :
. L4
O White space  © Commas|[] e PR e Active data set from SAS xport ﬂ.le
——e T S ERTRSTGRE T TIET Manage variables in active data set ¥ from SAS b7dat file...

| OOther Specify: ‘ O Other  Specify: from Minitab data set...

Decimal-Point Character | Decirn?l—Point Character | from STATA data set...
© Period [.] © Period [] )
) Commal,] ) Commal]] from Excel file...




Nuance with Remdr GUI’s menu options: Data import (+2)

R R Commander

File Edit Data Statistics Graphs Models Distributions Tools Help

” R Data set: | || <Mo active dataset> * Edit data set | |} View dataset  Modek | £ <No active model>

. . ]
* Note error with our demo file, ctg-studies csv.csv

satw C:/Users/wilkinskj/OneDrive - National Institutes of Health/Documents/Intramural;

ead.table ("C:/Users/wilkinsk]j/OneDrive - Hational Institutes of Health/Documents/Int:
header=TRUE, stringsAsFactors=TRUE, sep=",", na.strings="", dec=".", strip.white=TRUI

* Shows in Messages panel, in Red text

’ . . ’ —y setwd ("C: /Users/wilkinskj/OneDrive - National Institutes of Health/Documents/Intramur
* Can’t view the data set, as it’s not Active . o
What if # of commas in last column | s i s T R

* Checking the .csv file:

AutoSave I. c:ff::il = ctg-studies CSV.csv = Saved to this PC v

change row to row? How to import?

File Home Insert Page Layout Formulas Data Review View Automate Help JMP Acrobat

L A
L m - $ v % 9 [ZromatasTable v &~ Delete
Paste B Sh . A . = = = ¥= 3= | =5 - i - i {71 EE : Th no data sets

[ E——

”) e 0 .00
v = 0 -0 [iZ Cell Styles ~ t=t] Format v
Clipboard 5 Font N Alignment N Number [ Styles Cells

Aptos Narrow vl 11 o AYA 1, ab General - [E]]Conditimnal Formatting v E Insert ~
OS5 INalrrow L. di

.

from which

sS4 sz J Mational Institutes of Health Clinical Center, Bethesda, Maryland, 20892, United States

. = F G H | ] K L W N 0 P Q R )
mk Study Title Study URL Study Statu Conditions Interventio Primary Ou Secondary Sponsor  Collaborat Sex Age Enrollmeni Study Type Study Desi; Start Date Primary Cc Completiol Locations
09 Prebiotics https://clir COMPLETE Diabetes DIETARY_S Gastrointe Stool Short National Institute of Di ALL CHILD, AD & INTERVEN Allocation: ######## ###H#w#n #unnnnss National Institutes of Health Clinical Center, Bethesda, Maryland
37 Novel Ther https://clir TERMINAT! Diabetes I DRUG: Insi Change in ' Glycemia ( National Institute of Di ALL CHILD, AD 7 INTERVEN Allocation: 2009-02 2011-03 2011-03 Mational Institutes of Health Clinical Center, 9000 Rockville Pike,
60 Title: Therz https://clir COMPLETE Type 2 Diat DRUG: Lire Change in, Change in' National In Children's ALL CHILD, AD 24 INTERVEN Allocation: 5/9/2017 ######## ########l Mational Irlsﬂtutes of Health Clinical Center, Bethesda, Maryland
19 Mifepristor https://clir COM™-ETE Endocrine DRUG: Mifi Change in| Change in| Eunice Ker NationalIn ALL ADULT, OL 19 INTERVEN Allocation: ######## #ifrirf##d #H#HaRH# Naﬂonallnlstitutes of Health Clinical Center, 9000 Rockville Pike,
12 Studyto Ev https://clir CDf*!qq.:lTEAtheroscle DIETARY_S Mean IL-1 Beta Releas National Heart, Lung, ALL ADULT 38 INTERVEN Allocation: ######## #####4#4 ######## National Institutes of Health Clinical Center, Bethesda, Maryland




Nuance with Remdr GUI’s menu options: Data import (+2)

R R Commander

File Edit Data Statistics Graphs Models Distributions Tools Help

” R Data set: | || <Mo active dataset> * Edit data set | |} View dataset  Modek | £ <No active model>

. . ]
* Note error with our demo file, ctg-studies csv.csv

satw C:/Users/wilkinskj/OneDrive - National Institutes of Health/Documents/Intramural;

ead.table ("C:/Users/wilkinsk]j/OneDrive - Hational Institutes of Health/Documents/Int:
header=TRUE, stringsAsFactors=TRUE, sep=",", na.strings="", dec=".", strip.white=TRUI

* Shows in Messages panel, in Red text

’ . . ’ —y setwd ("C: /Users/wilkinskj/OneDrive - National Institutes of Health/Documents/Intramur
* Can’t view the data set, as it’s not Active . o
What if # of commas in last column | s i s T R

* Checking the .csv file:

AutoSave I. c:ff::il = ctg-studies CSV.csv = Saved to this PC v

change row to row? How to import?

File Home Insert Page Layout Formulas Data Review View Automate Help JMP Acrobat

L A
L m - $ v % 9 [ZromatasTable v &~ Delete
Paste B Sh . A . = = = ¥= 3= | =5 - i - i {71 EE : Th no data sets

[ E——

”) e 0 .00
v = 0 -0 [iZ Cell Styles ~ t=t] Format v
Clipboard 5 Font N Alignment N Number [ Styles Cells

Aptos Narrow vl 11 o AYA 1, ab General - [E]]Conditimnal Formatting v E Insert ~
OS5 INalrrow L. di

.

from which

sS4 sz J Mational Institutes of Health Clinical Cente -, biethesd 1, [1aryland, 20892, United States

. = F G H | ] K L W N 0 P Q R )
mk Study Title Study URL Study Statu Conditions Interventio Primary Ou Secondary Sponsor  Collaborat Sex Age Enrollmeni Study Type Study Desi; Start Date Primary Cc Completiol Locations
09 Prebiotics https://clir COMPLETE Diabetes DIETARY_S Gastrointe Stool Short National Institute of Di ALL CHILD, AD & INTERVEN Allocation: ######## ###H#w#n #unnnnss National Institutes of Health Clinical Center, Bethesda, Maryland
37 Novel Ther https://clir TERMINAT! Diabetes I DRUG: Insi Change in ' Glycemia ( National Institute of Di ALL CHILD, AD 7 INTERVEN Allocation: 2009-02 2011-03 2011-03 Mational Institutes of Health Clinical Center, 9000 Rockville Pike,
60 Title: Therz https://clir COMPLETE Type 2 Diat DRUG: Lire Change in, Change in' National In Children's ALL CHILD, AD 24 INTERVEN Allocation: 5/9/2017 ######## ########l Mational Irlsﬂtutes of Health Clinical Center, Bethesda, Maryland
19 Mifepristor https://clir COM™-ETE Endocrine DRUG: Mifi Change in| Change in| Eunice Ker NatioﬂnALL ADULT, OL 19 INTERVEN Allocation: ######## #ifrirf##d #H#HaRH# Naﬂonallnlstitutes of Health Clinical Center, 9000 Rockville Pike,

12 Studyto Ev https://clir CDf*!qq.:lTEAtheroscle DIETARY_S Mean IL-1 Beta Releas National Heart, . ALL ADULT 38 INTERVEN Allocation: ######## #####4#4 ######## National Institutes of Health Clinical Center, Bethesda, Maryland




Nuance with Remdr GUI’s menu options: Data import (+2)

R R Commander

File Edit Data Statistics Graphs Models Distributions Tools Help

R Data set: <MNo active dataset> * Edit data set | View data set  Modek | £ <No active model>

. . i 7)
* Note error with our demo file, ctg-studies csv.csy e

setwd ("C:/Usfrs/wilkinak]j/OneDrive - National Institutes of Health/Documents/Intramural/ Bios

le ("C:/Users/wilkinsk]/OneDrive - Hational Institutes of Health/Documents/Intramural
r=TRUE, stringaAsFactors=TRUE, sep=",", na.strings="", dec=".", strip.white=TRUE)

* Shows in Messages panel, in Red text

d not have 19

) ] What if # of commas in last column’
® . .
CheCkl ng the .C5V flle- change row to row? How to import?
1 auosave (@ oft) ] ctg-studies CSV.csv » Saved to this PC v £ search Issue: an entire “address” column’s content has comma-

o i

separated text itself, NOT ‘wrapped’ with quotes “ “ as a
single string in cell, & with varying number of commas

File Home Insert Page Layout Formulas Data Review View Automate Help JMP Acrobat

Ty X i ) Genera i ition: atting v
LD Aptos Narrow AT A ‘jt seneral [El]c::ndltlcmal rormating
Paste EB B hw AV | = = = e 5= )

v & = — 5 -2 [iZ Cell Styles v

Clipboard 5 Font (¥ Alignment (¥ Number ¥ Styles

$ v % 9 fiZ Format as Table v

Mational Institutes of Health Clinical Cente -, biethesd i, [Marylani, 21089, lInited States

; E F G H | J K L M N 0] P Q R )
mk Study Title Study URL Study Statu Conditions Interventio Primary Ou Secondary Sponsor  Collaborat Sex Age Enrollmeni Study Type Study Desi; Start Date Primary Cc Completiol Locations
09 Prebiotics https://clir COMPLETE Diabetes DIETARY_S Gastrointe Stool Short National Institute of Di ALL CHILD, AD & INTERVEN Allocation: ######## ###H#w#n #unnnnss National Institutes of Health Clinical Center, Bethesda, Maryland
37 Novel Ther https://clir TERMINAT! Diabetes I DRUG: Insi Change in ' Glycemia ( National Institute of Di ALL CHILD, AD 7 INTERVEN Allocation: 2009-02 2011-03 2011-03 Mational Institutes of Health Clinical Center, 9000 Rockville Pike,
60 Title: Therz https://clir COMPLETE Type 2 Diat DRUG: Lire Change in, Change in' National In Children's ALL CHILD, AD 24 INTERVEN Allocation: 5/9/2017 ######## ########l Mational Irlsﬂtutes of Health Clinical Center, Bethesda, Maryland
19 Mifepristor https://clir COMPLETE Endocrine DRUG: Mifi Change in| Change in| Eunice Ker National In ALL ADULT, OL 19 INTERVEN Allocation: ######## #H#H#HHHR #HH#HHHH Naﬂonallnlstitutes of Health Clinical Center, 9000 Rockville Pike,
12 Studyto Ev https://clir COMPLETE Atheroscle DIETARY_S Mean IL-1 Beta Releas National Heart, Lung, ALL ADULT 38 INTERVEN Allocation: ######## #####4#4 ######## National Institutes of Health Clinical Center, Bethesda, Maryland




Nuance with Remdr GUI’'s menu options: Data import (+3)

* Save as Excel (.xIsx) format, rven use Recmdr’s capacity to read columns

[ C: > Users > wilkinskj > OneDrive - National Institutes of Health > Documents >

* Importing using Excel format:




Nuance with Remdr GUI’'s menu options: Data import (+3)

Save as Excel (.xlsx) format, r#env use Remdr’s capacity to read columns

Save As

|—| Recent

Mational Institutes of Health

Excel Workboo

Recent

MNational Institutes of Health

’]’* [= C > Users > wilkinskj

l Excel

Workbook (*.xlsx)

Importing using Excel format:

R R Commander

File Edit Data Statistics Graphs Models Distnbutions Tools Help
R‘ Da sl bt set | Viewdataset Modek | X <No active model>
Load data set...

RScript | Merge data sets...

from text file, clipboard, or URL...

setwd (™ Data in packages L] from SP5SS data set... th/Documents/Intramural/_
CTGdatal  Active data set b from SAS xport file...
read. Manage variables in active data set Fron CAC bTdak file bf Health/Documents/Intra
headl bo=" W

from Minitab data set s Strip.white=TRUE)

from STATA data set...

from Excel file...

| “R' Import Excel Data Set

Enter name of data set: Dataset

| @ Variable names in first row of spreadsheet

{ [J Row names in first column of spreadsheet
> @ Convert character data to factors
Missing data indicator: <empty cell>

@Help q.// OK ‘ x Cancel

> OneDrive - National Institutes of Health > Documents >

5

7
950-207%°

NIDDK



Nuance with Remdr GUI’'s menu options: Data import (+3)

Save as Excel

Save As

|—| Recent

Mational Institutes of Health

Excel Workboo

Recent

MNational Institutes of Health

T

l Excel

(.xlsx) format, rven use Recmdr’s capacity to read columns

[ C > Users > wilkinskj > OneDrive - National Institutes of Health > Documents >

Workbook (*.xlsx)

Importing using Excel format:

R R Commander

File Edit Data Statistics Graphs Models Distnbutions Tools Help

) N data set... =
R' Da e aatas set | View dataset Modek | £ <No active model>
Load data set...
R Script R| Merge data sets...

from text file, clipboard, or URL...

setwd (™ Data in packages L] from SP5SS data set... th/Documents/Intramural/
CTGdatal  Active data set b from SAS xport file...
I:ead:.i Manage variables in active data set Fron CAC bTdak file bf Health/Documents/Intra
head.

=m " ot i = T
From Miniish dista set... pe="_"_, strip.white=TRUE)

from STATA data set...

from Excel file...

| “R' Import Excel Data Set

Enter name of data set: Dataset

| @ Variable names in first row of spreadsheet

{ [J Row names in first column of spreadsheet
= @ Convert character data to factors
Missing data indicator: <empty cell>

&) Help o oK ‘ ¢ Cancel

| (R Import Excel Data Set X |

Enter name of data set: CTGdatal
| @ Variable names in first row of spreadsheet

{ [CJ Row names in first column of spreadsheet
| @ Convert character data to factors
Missing data indicator: <empty cell>

& Help

q‘/ QK ‘ * Cancel

NIH)

NIDDK

5

7
950-207%°



Nuance with Remdr GUI’'s menu options: Data import (+3)

Save as Excel (.xlsx) format, r#env use Remdr’s capacity to read columns

Save As

|—| Recent

Mational Institutes of Health

Excel Workboo

Recent

MNational Institutes of Health

T [ C > Users > wilkinskj > OneDrive - National Institutes of Health > Documents >

Importing using Excel

format:

R R Commander

File Edit Data Statistics Graphs Models Distnbutions Tools Help
\ N data set... =
R' Da et s set | View dataset  Modek
Load data set...

RScript r|  Merge data sets...

from text file, clipboard, or URL...

setwd (™ Data in packages L] from SP5SS data set...

CTGdata Active data set L from SAS xport file...

rea d:-i Manage variables in active dataset from SAS b7dat file...
headt

from Minitab data set...
from STATA data set...

from Excel file...

X <MNo active model>

th/Documents/Intramural/

bf Health/Documents/Intra
pe="_"_, strip.white=TRUE)

| “R' Import Excel Data Set

Enter name of data set: Dataset

| @ Variable names in first row of spreadsheet
{ [J Row names in first column of spreadsheet
> @ Convert character data to factors

Missing data indicator: <empty cell>

&) Help o oK ‘ ¢ Cancel

Messages

| (R Import Excel Data Set X |

Enter name of data set: CTGdatal
| @ Variable names in first row of spreadsheet

{ [CJ Row names in first column of spreadsheet
| @ Convert character data to factors
Missing data indicator: <empty cell>

& Help

q/ QK ‘ g Cancel

[l0] HOTE: The dataset CTIGdata has 16 rows and 19 cnlms.m

5

7
950-207%°

NIDDK



Nuance with Remdr GUI’s menu options: Data import (+3)

* Save as Excel (.xIsx) format, r#en use Remdr’s capacity to read columns

Save As

@ Recent

National Institutes of Health

ctg-studies CSV

CSV (Comma delimited) (*.csv)

National Institutes of Health

T [ C > Users > wilkinskj > OneDrive - National Institutes of Health > Documents >

ctg-studies CSV

Excel Workbook (*xlsx)

* |Importing using Excel format:

R R Commander

File Edit Data Statistics Graphs Meodels Distributions Tools Help
New data set...

R Da set | | Viewdataset. Model:| £ <No active model>
Load data set... —
RScript p|  Merge data sets
setwd (" Data in packages [ from SPSS data set... fh/Documents/Intramural/_
CIGdata  Active data set *|  from SAS xport file...
T2ad.|  Managevariablesin activedataset  *|  from SAS b7dat file... £ Health/Documents/Intra
head. m - e pc=".", strip.white=TRUE)
from Minitab data set...
from STATA data set...
from Excel file...
Output

> getwd ("C:/Users/wilkinskj/On

| “R Import Excel Data Set

Enter name of data set: Dataset

@ Variable names in first row of spreadsheet
! [CJ Row names in first column of spreadsheet
: @ Convert character data to factors

Missing data indicator: <empty cell>

@Help l g’/ oK ‘ xCanceI

| “R Import Excel Data Set X |

| | Enter name of data set: CTGdatal

| @ Variable names in first row of spreadsheet
i [ Row names in first column of spreadsheet
| @ Convert character data to factors

Missing data indicator: <empty cell>

@Help W x Cancel

Messages

[10] NOTE: The dataset CTGdata has 16 rows and 19 columns.
YEARS

e And the new Remdr-generated code of ‘readXL’ is echoed NIDDK

7950_502°



Additional options in Remdr GUI’s menus: Data (+1)
With data now imported, we can add columns to data frame via menu

~* Possible as we have Active dataset in Blue

B Delete variables from data e

N

[

variables in a different form (‘factors’), via (sub)menu: - _

Re-us

resmiben o dsts

» After NEW column add, ‘refresh’ the Active dataset to use it, as below
* And note new variable available: see correl. dialog

()



Additional options in Remdr GUI’s menus: Data (+1)
With data now imported, we can add columns to data frame via menu

~* Possible as we have Active dataset in Blue

B Define contrasts for a factor..

Rensme variabd . ' @Hm ® Reset o OK l R cance # Apply

N

kj fOneDr Delete variables from data

[

variables in a different form (‘factors’), via (sub)menu: —_

Re-us

S ——— b B

Compaty
rramiben io dats

» After NEW column add, ‘refresh’ the Active dataset to use it, as below
* And note new variable available: see correl. dialog

NIDDK 75



Additional options in Remdr GUI’s menus: Data (+1)

With data now imported, we can add columns to data frame via menu
* Possible as we have Active dataset in Blue

File Edit Data Statistics Graphs Models Distributions Tools Help

R R Commander
File Edit Data Statistics Graphs Models Distributions Tools Help

R-‘ Data set: CTGdata ,_" Edit data set | View data set Model: | X <No active model>
R D e l:renmm Modek X <Mo active model>
Load data set.

RSerpt g  Merge data set R Compute Mew Variable e

Re-using & customizing code /

CTGdata| Impor data Current variables (double-click i
. Deta in pockages dational Institutes of Heal urrent vanables (double-click to expression)

nead|  Active dats set b | sep=",", na.scrings="v, dec=w,", | Age [facter]

- | iCollaborators [factor]
- ers/wilkinsks/OneDrive IMAUIIEIRCCS —I | [Completion.Date [factor] X MEMEELC{AS-CHATACCEE (CICAREROSTATE.DACE) 0  avate a1a0c . . - .
N - ade _— pmt Add observalion numbers to dats set bos [ Canditions [factor] [1] 43500 HAR 42864 40B7¢€ 42544 42111 HA HA HA 41416 41300 HA HA HA 41&05 HA
Standardize vasiables... | |DaysainceQriginDate
1 Coarvet numens van albles to factors... i’ Enroliment min( as me: (as arac (CTGdata Da | a =T ]
vt Character variables t | New variable name Expression to compute [1]1 40876
Output Bin mumeric varisble... DaysSinceQriginDate fps.nmumeric (as.character (Starc. —_—
Recrder factor levels... I Fil s (CTGd art.Date) m=TH ]
______ akd / Drop unused factor levels...
T Define contrasts for a factor. ) | | » CIGdatafDaysSinceEarliesctStart <- with(CTGdata, (| as.numeric(as.character(Startc.Date))
Rename varisbles... @Halp j Reset q,f oK l x Cancel r'!' Apply B = EarliesstDate ) )
'ea_’}ill'::-".':e::-'p';'_lc;::slc:-'2:'.-.-::'_ Dedete vaniables from data set ... R

Re using variables in a different form (‘factors’), via (sub)menu:

. After NEW column add, ‘refresh’ the Active dataset to use it, as below.
* And note new variable available: see correl. dialog

NIDDK 5

7950-207°



Additional options in Remdr GUI’s menus: Data (+1)

-

R R Commander

File Edit

R o
RSenpt R
CIGdata

oead.
head

CTGdatca

Data  Statistics Graphs  Models Distributions Tools  Help

MNew data set..
Load data set...

Import data
Data in packages
Actnre data set

Manage variables in active data set

readXL ("C:/Users/wilkinski/OnaDrive

rownames=FRIEF header=TRUE, n

Oustput

senwd

CTIGdata

+ Iea

* And note new variable available: see correl. dialog

dXL (®C: /Users/

fOsers/wilkinsky /OneDeiv

wilkinskd /S

E— - —

View data set.  Modek X <No active model>

ve - Haticnal Imatitutes of Heal
sep=",", na.scrings="",
Recode vanables...
Compute new vanable..

deg=".",

Add obzervation numbers to data set

Bgs
Standardize variabdles...
Convert numenc vanables to factors... i'
Ban numenc vanable... I
Recrder factor levels...

Drop unused factor levels...
Define contrasts for a factor...
Rename vanables...

Delete vaniables from data set ...

| New variable name

With data now imported, we can add columns to data frame via menu
* Possible as we have Active dataset in Blue

R Compute MNew Variable X

Current variables (double-click to expression)

| Age [facter]
| ICollaborators [factor]

Completion.Date [factor]

| [Cenditions [factor]
| DaysSinceOriginDate

Enrollment
Expression to compute

DaysSinceOnginDate |as umeric (as.character (Starc.

@Htlp ® Reset q,f oK l x Cancel .r'-'!' Apply

Re-using variables in a different form (‘factors’), via (sub)menu:

-
R R Commander

File Edit Data

R-‘ Data set:

Statistics Graphs Models Distributions Tools Help

CTGdata

,_" Edit data set Model: | X <No active model>

|€) View data set

Re-using & customizing code /

Qutput

» as.numeric(as.character (CIGdatasStart.Date) )

[1] 43%00 MR 42864 40876 42544 42111 HR HA MA 41416 41300 HA HA MR 41€05 2F=
» min( as.numeric(as.character (CIGdacasStarc.Date) ), na.rm=TRUE )
[1] 40876
» EarliescDate <- min{ as.numeric(as.character (CTGdacaS5carc.Date) ), na.rm=TRUE )
» CIGdatafDaysSinceEarliesctStart <- with(CTGdata, (| as.numeric(as.character(Startc.Date))
- = EarlisstDate ) )
W R Lormmander
Fie i Dsin Ssimccr Geaphs  bgdeh Detviestmen  Tesh  Hsip

Be P it el
R Lowd dais sei.
Bicrpr | Marge daia ueh

R R Commander

i File Edit Data Statistics Graphs Models Distributions Tools Help

MNew data set...
Load data set...

| R Dai

View data set Model: | £ <No active model>

R Script R Merge data sets..
Import data »
= ) . ~ N
CTGdaca Data in packages p Fdata, as.numeric(as.character (5ta:
T 1| ’ .
Earlies Active data set View data... |
¥

CTGdataSDaysSinceEarliestStart <- wit] Refresh active data set

Manage variables in active data set

- EarlisstDate ) )

Vi ik i b

Select active data set...

Help on active data set (if available)
Vanables in active data set

Set case names...

Subset active data set...

Sort active data set...




-

R R Commander

File Edit Data Statistics Graphs

MNew data set..
R Load data set...
RSenpt R M R L
CTGdata  Import data
read. Data in packages

head  Active dats set

CTGdatca

Manage variables in active data set

reagd¥L ("C: /Users,/ wilkir

rownames=FRLEF header=T

Models Distributions Tools Help

View data set.  Modek X <No active model>

R Compute MNew Variable

ve - Macicmal Imatitutes of Heal [ Current variables (double-click to expression)
sep=",", nA.STrings="", dec=".", Age [factor]
Recode vanables... | iCollaborators [factor]

Standardize variables... DaysSinceOriginDate
Convert numenc vanables to factors... i' Enroliment

Compute new vanable.. Completion.Date [factor]
Add observation numbers to data set tas I Conditions [factor]

Additional options in Remdr GUI’s menus: Data (+1)
With data now imported, we can add columns to data frame via menu
* Possible as we have Active dataset in Blue

R R Commander

File Edit Data Statistics Graphs Models Distributions Tools Help

R-‘ Data set: CTGdata ,_" Edit data set | View data set Model: | X <No active model>

Re-using & customizing code /

Qutput

» as.numeric(as.character (CIG
[1] 43%00 MR 42864 4087

HA MA 4141€ 41300 HA HA MR 41€05 HA

» min( as.numeric(as.characcer (CTGdacta$Starc.Dacte)

riables to fact I | MNew variable name Expression to compute [1]1 40876
::;::e':‘:;.:l:::: CayzsinceOnginDate hs.nm&:xc:a#.cha:ac:e:[Staxc. EarliesctDate <- min( as.numeric(as.character (CTGdata$Starc.Date) ), na.rm=TRUE )
Drop unused factor levels... -
Define contrasts for a factor.. - | —_— » CTIGdatafDaysSinceEarliestStart <- with(CIGdata, ( as.numeric(as.character(Stazt.Date))
Rename varisbles... @Halp :, Reset q,/ oK l x Cancel B = EarliesstDate ) )

Delete variables from data set ... fet

Re-using variables in a different form (‘factors’), via (sub)menu: =

W R Commandei
Fie Fdn Duin ey Goaghs Medeh Duiestos Toph Heip

P it el
L B

AFELEutEs SF Beal

Firt pate i
Loy febem < bribbde.
el sbiar shon rumben o e

MAarg e i BV et

. After NEW column add, ‘refresh’ the Active dataset to use it, as below

* And note new variable ava

R Correlation Matrix

Vanables (pick two or more)
DaysSinceOnginDate

Enrollment

| Type of Comelations
| () Pearson product-moment
© Spearman rank-order
) Partial
Observations to Use
© Complete observations

| () Pairwise-complete observations

) Pairwise p-values

@ Hep %) Reset oK 3¢ Cancel

R R Commander

i Ia b I e : See CO rrel . d ia Iog : File Edit Data Statistics Graphs Models Distributions Tools Help

MNew data set...

| R Dai View data set Model: | £ <No active model>
Load data set...

R Script R1 Merge data sets..

Import data b
= . - > i
CTGdata Data in packages » data, as.numeric(as.character(5ta:
Active data set b View data...
Earlies . . : ) I
Manage variables in active data set b Select active data set...

CTGdataSDaysSinceEarliestStart <- wit] Refresh active data set

- EarliestDate ) ) Help on active data set (if available)
Vanables in active data set
Set case names...
Subset active data set...
Fa T THY Sort active data set...




Additional options in Remdr GUI’'s menus: Data (+1)

With data now imported, we can add columns to data frame via menu

* Possible as we have Active

r
R R Commander

File Edit Data Statistics Graphs Models Distributions Tools Help
2 New data set...

R 0 o View dataset  Modek | z <No active model>

Load data set...

RScript R|  Merge data sets R Compute New Variable

CTGdata| Importdata L 5 3 -
read.| Datain packages bhve - National Institutes of E Current variables (double-click to expression)
head{  Active data set » | sep=",", na.strings="", dec=".", \Age [factor]

Collaborators [factor]

R R Commander

File Edit Data

E Data set:

dataset in Blue

Statistics

CTGdata

Graphs Models Distributions Tools Help

_' Edit data set | View data set Model: | £ <MNo active model>

x Re-using & customizing code /

O nogc oible nacive doacct_ MESSTUC ‘ , P
| Iesd.XL("C:/Users/wllklnsk‘/OneDIlve;I/D | Cnmglstmn‘Date[factur] A \--._‘ fta.;\t.‘a‘_t..zte] 4 - o0 -0
rownames=FALSE, hesdeI;T;{UE, na=nn|  Add observation numbers to data set Los | Conditions [factor] 76 42544 42111 NA NA NA 41416 41300 NA NA NA 41€05 NA

Standardize variables... DaysSinceOriginDate
Convert numeric variables to factors.. | Enrollment min( as.numeric(as.character (CTIGdata$Start.Date) ), na.rm=TRUE )
Convert character variables to factors... | | New variable name Expression to compute [1] 40876

Output LA DaysSinceOriginDate |ps.numeric (as.character (Starc. o e e poomesn e s g I
Reorder factor levels... EarliestDate <- min( as.numeric(as.character (CIGdataSStart.Date) ), na.rm=TRUE )

s st et Drop unused factor levels... = . . " - . e . -
Define contrasts for a factor... . —————— ., | > CIGdata$DaysSinceEarliestStart <- with(CTIGdata, ( as.numeric(as.character (Start.Date))
Rename variables... @ Help ) Reset @’/ 0K } x Cancel  Apply + - EarliestDate ) )

C:/Users/wilk: Delete variables from data set ... R4 R R Commander

o After NEW column add, ‘refresh’ the Active dataset to use it, as below

* And note new variable avai

| “R Correlation Test

| Variables (pick two)
DaysSinceEarliestStart
DaysSinceOriginDate
Enroliment

Type of Correlation Alternative Hypothesis
© Two-sided
(O Correlation < 0

() Correlation > 0

<:—';\ Reset W 0K ‘ x Cancel

© Pearson product-moment
() Spearman rank-order
| () Kendall's tau

| @ Help

& Apply

lable: see correl. dialog

Re-using variables in a different form (‘factors’), via (sub)menu:

File Edt Data Statistics Graphs Models Ditributions Tools Help
New data se...

R >

View data set  Modek |  <No active mod

Import data »
Data in packages »
Active data set » | - Nacional Institutes of Heal

bIGdata
=

Recode vari

(watze, ncrare] | COmPute new vaisble

zcorr.adjust (DIGdatal[, c("BMI", "CREAT| Add observation numbers to data set

‘Convert numeric variables to factors...

haracter variables to factors.

R R Commander

File Edit Data Statistics Graphs Models Distributions Tools Help
\ New data set... ) =

R‘- Dal st View dataset  Model: | £ <No active model>
Load data set...

R Script Rl  Merge data sets

[ Import data »

|CIGdata| Data in packages » Gdata, as.numeric(as.character (Sta:

| ) I Active data set » View data...

|[Earlies| I
Manage variables in active data set » Select active data set...

|cTGdata$DaysSinceEarliestStart <- wit] Refresh active data set 5

- EarliestDate ) ) Help on active data set (if available)
Variables in active data set

Set case names...

Subset active data set...

Sort active data set...

[ TT Ty



Occasional issues in Rcemdr GUI's menus: Data (+2)

* With data now imported, we view categorical vars via bar chart
* Possible with Active dataset in Blue; may be issues with string data as below

* Replace with Acronyms

Study. Status
@ COMPLETED B TERMINATED

. e Use alt. string labels
] J

T




Occasional issues in Rcemdr GUI's menus: Data (+2)

* With data now imported, we view categorical vars via bar chart

* Possible with Active dataset in Blue; may be issues with string data as below
* Replace with Acronyms

Study. Status
O COMPLETED ®E TERMINATED

. e Use alt. string labels
] J

T

reque

o -

0
ly Shriver National Institute of Child Health and Human Development (NICHD) Mational Cancer Institute (NCI) Mational Heart, Lung, and Blood Institute (NHLBI)

Sponsor




Occasional issues in Rcemdr GUI's menus: Data (+2)

* With data now imported, we view categorical vars via bar chart

* Possible with Active dataset in Blue; may be issues with string data as below
* Replace with Acronyms

Study. Status
O COMPLETED ®E TERMINATED

. e Use alt. string labels
] J

T

reque

o -

0
ly Shriver National Institute of Child Health and Human Development (NICHD) Mational Cancer Institute (NCI) Mational Heart, Lung, and Blood Institut[ (MHLBI)

Sponsor




Occasional issues in Remdr GUI’s menus: Data (+2)

* With data now imported, we view categorical vars via bar chart

* Possible with Active dataset in Blue; may be issues with string data as below

* Replace with Acronyms

Study_Status
O COMPLETED B TERMINATED

. e Use alt. string labels
] J

T

| o o o e L D

0

ly Shriver National Institute of Child Health and Human Development (NICHDY National Cancer Institute (NCI) National Heart, Lung, and Blood Institut®¢ (NHLBI)
Sponsor
YYYYY
7950_202°




Occasional issues in Remdr GUI’'s menus: Data (+3)

* With data now imported, we view the data frame via menu or button
® Possible as we have ACti\Ie dataset in Blue File Edit Data Statistics Graphs Models Distributions Tools Help

R Data set: CTGdata y J Edit data set | ) View data set Model: | £ <No active model>

Re-using menu option & selecting a smaller column subset: still errors

Messages

* Bottom Line: if you encounter errors, it may be data

* Can create subset,
* then ‘refresh’ the Active dataset (@ right)
e then try again... let us know if you get it working!

[13] ERROR: View data error.
[l14] ERROR: View data error.




Occasional issues in Remdr GUI’'s menus: Data (+3)

* With data now imported, we view the data frame viamenu) or button
® Possible as we have ACti\Ie dataset in Blue File Edit Data Statistics Graphs Models Distributions Tools Help

R Data set: CTGdata y J Edit data set | ) View data set Model: X <Mo active model>
R R Comman der
Edit Data Statish G Mod Distributions p
N ta set
R0 e datas View data set  Mod
Load data set...
RS pt R| I'.:"':L]t" jata
Import dat P lational Institutes of Health/Documents/Intramur:
Data in packages L
/Docunenta/
Manage variab d 3 Select active data set... =strip.whice=TI
rrrrrr ("C:/Users/wilkinskyj/OneDrive Refresh active data set ume ' an
mames=FAL =rnn Help on active data set (if available) Fac E)
Vanables in active data set

Re-using menu option & selecting a smaller column subset: still errors

Messages

* Bottom Line: if you encounter errors, it may be data
* Can create subset,
* then ‘refresh’ the Active dataset (@ right) m) 7
* then try again... let us know if you get it working! NIDDK 5

[13] ERROR: View data error.
[l14] ERROR: View data error.




Occasional issues in Remdr GUI’'s menus: Data (+3)

* With data now imported, we view the data frame viamenu) or button

R R Comman der

° Possible as we have ACti\Ie dataset in Blue File Edit Data Statistics Graphs Models Distributions Tools Help

_ R'l Data set: CTGdata / J Edit data set | ) View data set Model: | £ <No active model>
R R Comman der =
File Edit Data Statistics Graphs Models Distributions Tools Help - @ Include all variables
_ \ [ or
: New data set... .
R Da s data s View data set Model | £ <MNo active model> | Variables (select one or more
Load data set... | thge
Hsfflpt RI I.'.l:"':'J:" data sets.. : Completion.Date
uuuuuuuuuu
setwd (" Import data * lational Institutes of Health/Documents/Intramur: | Enroliment
CTGdata Data in packages » | Mnterventions
-rﬂztad Manage vanables in active data set » Select active data set... prrip.whice=Tl
CTGdata _
rrrrrr ("C:/Users/wilkinskj/OneDrive =l a-:tr*_u'e TEs ] _ uments/Intran ]
rownames=FALSE, header=TRUE, na="~  Help onactive data set (if available) Factors=TRUE) @ Help “ hd | ¥ concel
Variables in active data set

Re-using menu option & selecting a smaller column subset: still errors

Messages

* Bottom Line: if you encounter errors, it may be data
* Can create subset,
* then ‘refresh’ the Active dataset (@ right) m) 7
* then try again... let us know if you get it working! NIDDK 5

[13] ERROR: View data error.
[l14] ERROR: View data error.




Occasional issues in Remdr GUI’'s menus: Data (+3)

* With data now imported, we view the data fram

omman der

File Edit Data Statistics

R Data set:

CTGdata

* Possible as we have Active dataset in Blue

- -
R R Comman der nV
File Edit Data Statistics Graphs Models Distributions Tools Help - @ Include all variables
) : [ oR
: New data set... .
R‘] Da View data set Model: X <No active model> Variables (select r m
Load data set... Age
. Y e e Collaborat
R Script R | e el | |Completion.Date
nnnnnnnnnn
serwd ("  Import data P lational Institutes of Health/Documents/Intramurz | [Enroliment
CTGdata Data in packages » | Mnterventions
" - <all cases>
‘Tﬂzead Manage variables in active data set L Select active data set... prrip.whice=Tl
Ll 5
rrrrrr ("C:/Users/wilkinskyj/OneDrive Refresh a-:tr*_u'e data set ] _ uments/Intran ]
mames=FALSE ader=TRUE " Help on active data set (if available) Factors=TRUE) @ Help Reset o | K Cancel
Vanables in active data set

e viamenu

button

or

Graphs Models Distributions Tools

/ ’ Edit data set | &) View data set

Help

Model: | £ <No active model>

R R Commander

File Edit Data Statistics

R‘ Data set:

R Script R Markdown

CTGdata

Graphs Models Distributions Tools

/" Edit data set ) View data set]

Re-using menu option & selecting a smaller column subset: still errors

* Bottom Line: if you encounter errors, it may be data

* Can create subset,
* then ‘refresh’ the Active dataset (@ right)
e then try again... let us know if you get it working!

Messages

[13] ERROR:
[14] ERROR:

View data error.
View data error.

NIDDK 75



Occasional issues in Remdr GUI’'s menus: Data (+3)

* With data now imported, we view the data fram

R R Comman der

File Edit Data Statistics

R Data set:

CTGdata

* Possible as we have Active dataset in Blue

- -
R R Comman der R Vi
File Edit Data Statistics Graphs Models Distributions Tools Help - @ Include all variables
[ oR
New data set... .
R‘1 Da View data set Model: X <No active model> | Variables (select one or more
Load data set... | fAge
. Y e e Collaborators
R Script R| amiEe t i | iCompletion .Date
| IConditions
serwd ("  Import data P lational Institutes of Health/Documents/Intramurz | [Enroliment
CIGdata Data in packages ¢} | |nterventions
i head M 3 Select active data set... o T
CTGdata

Refresh active data set
" Help on active data set (if available)
Vanables in active data set

uments/Intran
Factors=TRUE)

»
AL Active data set | View data... 1/Documents/Ir | Subsetexpression
e strip.white= <all cases>
@Help .ly Reset

Re-using menu option & selecting a smaller column subset: sti
* Bottom Line: if you encounter errors, it may be data

* Can create subset,
* then ‘refresh’ the Active dataset (@ right)
e then try again... let us know if you get it working!

e via

menu

button

or

Graphs Models Distributions

/" Edit data set

Tools Help

|6] View data set Model: | £ <No active model=

R R Commander

R‘ Data set:

R Script R Markdown

>

Messages

File Edit Data Statistics

CTGdata

Graphs Models Distributions Tools

" Edit data set ||} View data set]

Messages

[12] ERROR:
data frame too wide

| errors

[13] ERROR:
[14] ERROR:

View data error.
View data error.

NIDDK 75



Occasional issues in Remdr GUI’'s menus: Data (+3)

* With data now imported, we view the data frame

R R Comman der

R} Dataset| | CTGdata
] R Vi
R R Comman der
File Edit Data Statistics Graphs Models Distributions Tools Help - @ Include all variables
) . [ or
: New data set... .
R‘1 Da W 02 5 View data set Model: | X <No active model> | Variables (select one or more
Load data set... | tAge
Hsfflpt RI I.'.l:"':'J:" data sets.. : Completion.Date
uuuuuuuuuu
setwd (™ Import data
CIGdata Data in packages L

rip.whice=TE

Refresh active data set

uments/Intran

via menu orbutton

/" Edit data set

° Possible as we have ACti\Ie dataset in Blue File Edit Data Statistics Graphs Models Distributions Tools Help

|6] View data set Model: | £ <No active model>

R R Commander

File Edit Data Statistics Graphs Models Distributions Tools

R‘ Data set: CTGdata /" Edit data set ||} View data set]

R Script R Markdown

Messages

tional Inst of Health/Documents/Intr
| Interventions [
zead. /Documenca/X: (NSNS
head - . . = =t <all cases>
Manage variables in active data set L Select active data set...

rownames=FALSE, heade;t=TE'JE:‘ na="n Help on active data set (if available)
Variables in active data set

Fac::r.c:s=:l‘R'JE] O rew © Reset o oK | &K Cancel |

Re-using menu option & selecting a smaller column subset: sti

* Bottom Line: if you encounter errors, it may be da

* Can create subset,
* then ‘refresh’ the Active dataset (@ right)
e then try again... let us know if you get it working!

[13] ERROR: View data err

or.

ta

> [12] ERROR:

data frame too wide

| errors

Messages

[13] ERROR: View data error.
[l14] ERROR: View data error.

NIDDK 75




Occasional issues in Rcemdr GUI’s menus: Data (+3)

* With data now imported, we view the data frame via menu) or(button

R R Commander

o POSSIbIe aS We have Act|ve dataset In Blue File Edit Data Statistics Graphs Models Distributions Tools Help

S R Data set: CTGdata * Edit data set |5] View data set Model: | £ <No active model>
r : R V«ew Data X | —
R R Commander
File Edit Data Statistics Graphs Models Distributions Tools Help i ’On‘"dudg s R R Commander
New data set... -
N | - . P = Variables (select one or more) . . . e . -
B 02 dstscet. View data set  Model: | X <No active model> | foge ‘ File Edit Data Statistics Graphs Models Distributions Tools
= Mesge dats b | [Collaborators
cript Rl b | E:"mdﬂ:';” Date R Data set: CTGdata * Edit data set E) View data set]
: : | I A L
.setwd[" Import data ? lational Institutes of Health/Documents/Intramur: | Enroliment
CTGdata| Data in packages 4 ([interventions ‘ R Script R M
. arkdown

head

= <all cases>
e Manage variables in active dataset  » Select active data set... prrip. w‘ute IF Mf_'.sages
C atal X |
readXL ("C:/Users/wilkinsk]j/OneDrive Refresh active data set i . uments/Intran R - » o S
rownames=FALSE, header=TRUE, na="" Help on active data set (if available) Factors=TRUE) | @ Help ) pesd o Ok ‘ 8 concel [ L& I ERROR:

Variables in active data set

[13] ERROR: View data error.

data frame too wide

Re-using menu option & selecting a smaller column subset: still errors
Bottom Line: if you encounter errors, it may be data | =

[1L3] ERROR: View data error.
[1l4] ERROR: View data error.

* Can create subset, E=—

New data set...

- Viewdataset  Modek:| % <No active model>
Load data set...

Models Distributions Tools Help

R Script R Merge data sets.

* then ‘refresh’ the Active dataset (@ right)

Data in packages

I Active data set 0 viewdata..
Earlies

Manage variables in active dataset  » Select active data set...

CTGdataSDaysSinceEarliestStart <- wit! Refresh active data set

* then try again... let us know if you get it working! e

Set case names...
Subset active data set...
Qutput Sort active data set...




Non-Excel import via Rcmdr GUI’s menus: Data (+2)

* Importing using SAS format: =

File Edit Data Statistics Graphs Medels Distributions Teols Help

MNew data set...
\) Da Fwdata View data et Model: | £ <Mo active
Load data set
oad data set...
R Script R Merge data sets...

library from text file, clipboard, or URL..

numSamm Data in packages L4 from 5P55 data set...
-5, .7 Active data set 4 from SAS xport file...
»

I num3umn Manage variables in active data set
"uan reoa vy roer

from SAS b7dat file...
from Minitab data set...

numSummary (CTGdata[, "Enrollment™, dro from STATA data set...
from Excel file...
numSummary (CTGdata[, "Enrollment”, drop=FALSE], groups=CIGdatasStiR Import Excel Data Set x|

R R Commander .. R Import Excel Data Set * | | Enter name of data set: CTGdatﬂ

File Edit Data Statistics Graphs Models Distributions Tools Help Ent of data set: Dataset @ Variable names in first row of spreadsheet
1 nter name 5 atas

I [[J Row names in first column of spreadsheet

New data set... | . - e | |
ﬂf Da Fatd ok set | Viewdataset, Model: | £ <No active model>| @ Variable names in first row of spreadsheet > @ Convert character data to factors
RScript R Merge data sets.. ' [J Row names in first column of spreadsheet Missing data indicator: <empty cell>
. > @ Convert character data to factors —

lsetwd (" Data in packages from SPSS data set... th/Documents/Intramural/_ Missing data indicator: <empty cell> @ s x s

»
|
CIGdata  Active data set ¥l from SASxport file... - | |
read. Manage variables in active data set 3 from SAS b7dat file... £ Health/Documents/Intra @ Help x Cancel
head! w - | e pc=".", strip.white=TRUE)
from Minitab data set... | |
from STATA data set...
from Excel file...
I \ 4
Messages
Output
> setwd("C:/Users/wilkinskj/OneDrive - National Institutes of Health/Documents/Intramural/_ B
[10] NOTE: The dataset CIGdata has 1€ rows and 19 columns.
> CTGdata <-
+ read.table ("C:/Users/wilkinskj/OneDrive National Institutes of Health/Documents/Intramu :
+ header=TRUE, stringsAsFactors=TRUE, sep=",", na.strings="", dec=".", strip.white=TRUE) d YEARS
> CIGdata <-

D e s mee e ane. And the new Remdr-generated code of ‘readXL is echoed  NIDDK e



National Institute of .
m e 75 how ‘default’ steps to analysis (GUI-

and Kidney Diseases

enerated code) can be customized to your use
Scatterplot matrices: ‘group-based’ graph menu now offers factors

‘R Convert Numeric Variables to Factors X |

. Variables (pick one or more) Factor Levels

| ISVADAYS © Supply level names
. SYSBP

| ) Usenumbers

UANG
UANGDAYS I
VASOD

New variable name or prefix for multiple variables: TRTMT_factori

& Help [ o oK } ¢ Cancel




National Institute of .
m e 75 how ‘default’ steps to analysis (GUI-

and Kidney Diseases

enerated code) can be customized to vour use

Scatterplot matrices: ‘group-based’ graph menu now offers factors

ll R Convert Numeric Variables to Factors X | ,I R Level Names for TRTMT _factor X
. Variables (pick one or more) Factor Levels | ' Numeric value Level name
| [SVADAYS © Supply level names | 10 PLACEBO

SYSBP |_’
’ I
| O Use numbers | . DIGOX M

UANG :
| UANGDAYS I | [ w 0K } x Cancel 1
| VASQOD \
| New variable name or prefix for multiple variables: TRTMT_factori |
r I

& Help [ o oK } ¢ Cancel ‘




National Institute of .
m e 75 how ‘default’ steps to analysis (GUI-

and Kidney Diseases

enerated code) can be customized to your use
Scatterplot matrices: ‘group-based’ graph menu now offers factors

ll R Convert Numeric Variables to Factors X | ,I R Level Names for TRTMT _factor X
. Variables (pick one or more) Factor Levels | ' Numeric value Level name
| [SVADAYS © Supply level names | 10 PLACEBO |
SYSBP |_’ B
’ I
| O Use numbers | . DIGOX M
UANG :
| UANGDAYS I | [ w 0K } x Cancel 1
| VASOD . \ J
| New variable name or prefix for multiple variables: TRTMT_factori |
f

| v

@HE| (’/ 0K x Cancel > DIGdata <- within (DIGdata, {
P + TRTHT_faCtDI <- factor (TRIMI, labels=c('PLACEBO', 'DIGOXIN'"))

+ 1)




National Institute of .
e 75 how ‘default’ steps to analysis (GUI-

andKidneyDiseases %= generated code) can be customized to your use
Scatterplot matrices: ‘group-based’ graph menu now offers factors

ll R Convert Numeric Variables to Factors X | ,I R Level Names for TRTMT _factor X
. Variables (pick one or more) Factor Levels | ' Numeric value Level name
| [SVADAYS © Supply level names | 10 PLACEBO
[ O Use numbers | l 1 DIGOXIM
UANG |
' |
 UANGDAYS | | [ of OK 1 R Cancel
| VASOD \ J
| New variable name or prefix for multiple variables: TRTMT_factori |
r | v
> DIGdata <- within (DIGdata, {
@ Help [ J OK ] x Cancel ‘ —+ TRIMT factor <- factor (TRTMT, labels=c('PLACEBOC','DIGOXIN'))

e }]
R R Commander

File Edit Data Statistics Graphs Models Distributions Tools Help

\ -R Scatterplot Matrix

R Data Options

Select vanables (three or more) R Groups X
CHFDUR
CHFETIOL | Groups variable (pick one)
I CREAT TRTMT factor &
CREAT _becnPower
CREV .
I (CREVDAYS
Plot lines by group @

Plot by groups... |



National Institute of .
e 75 how ‘default’ steps to analysis (GUI-

andKidneyDiseases %= generated code) can be customized to your use
Scatterplot matrices: ‘group-based’ graph menu now offers factors

ll R Convert Numeric Variables to Factors X | ,I R Level Names for TRTMT _factor X
. Variables (pick one or more) Factor Levels | ' Numeric value Level name
| [SVADAYS © Supply level names | 10 PLACEBO
[ O Use numbers | l 1 DIGOXIM
UANG |
' |
 UANGDAYS | | [ of OK 1 R Cancel
| VASOD \ J
| New variable name or prefix for multiple variables: TRTMT_factori |
r | v
> DIGdata <- within (DIGdata, {
@ Help [ J OK ] x Cancel ‘ —+ TRIMT factor <- factor (TRTMT, labels=c('PLACEBOC','DIGOXIN'))

e }]
R R Commander

File Edit Data Statistics Graphs Models Distributions Tools Help

\ -R Scatterplot Matrix

R Data Options

S Select variables (three or more) R Groups X

CHFDUR
CHFETIOL | Groups variable (pick one)

I CREAT TRTMT factor &
CREAT bcnPower
CREV .

! (CREVDAYS

Plot lines by group @

Plot by groups... |



National Institute of

Diabetes and Digestive
and Kidney Diseases

F

Scatterplot matrices: ‘group-based’ graph menu now offers factors

"R Convert Numeric Variables to Factors X | “R Level Names for TRTMT factor X _
| Variables (pick one or more) Factor Levels ' Numeric value Level name
| |SVADAYS © Supply level names ' |0 PLACEBO '
| pYs8P () Use numbers _>I 1 DIGOXIN| ]
|
UANG
UANGDAYS | — | [ o OK 1 ¥ cancel
VASQOD | i
New variable name or prefix for multiple variables: TRTMT factor
A\ 4

[ > DIGdata <- within(DIGdata, {
Help OK ¥ Cancel | . .
- IRIHT_faC‘L’.DI <- factor (TRTMI, labels=c|('PLACEBO', 'DIGOXIN"'))

| + })

R R Commander

File Edit Data Statistics Graphs Models Distributions Tools Help

\ 4

W (R Scatterplot Matrix 5

1.30 1.35 1.40
| | | R
= PLACEBO & 8 Data Options
BMI 4 DIGOXIN L i‘fﬁ H ¥
o _Select variables (three or more) R Groups %
2 CHFDUR
of ° 5 : OL | Groups variable (pick one)
E . MU CREAT benPower (] theics -
In P 1T TR M N TR N 1 Q c‘_'D‘_ o = CREV =
- =] CREVDAYS |
- i £t o ; |
o é‘ﬂ BMI %%WEI’ Plot by groups... | | Plot lines by group 2 |




For the morbidly curious about Remndr GUI: relies on tcl/tk

Per the Tcler's Wiki:

« Whatis Tcl?

 Tcl is a simple-to-learn yet very powerful programming language.
Its syntax is described in just a dozen rules, but it has all the
features needed to rapidly create useful programs in almost any
field of application - on a wide variety of international platforms.
See more about Tcl at What is Tcl

 What is Tk?

* Tk is a graphical toolkit for Tcl. It allows you to develop graphical
applications that run on Windows, Linux, MacOS X and many
other platforms. And not just from Tcl - Tk can be used from

many languages including C, Ruby, Perl, Python and Lua. Seem) 7
more about Tk at \What is Tk A&

7950-207°



https://wiki.tcl-lang.org/
https://wiki.tcl-lang.org/page/What+is+Tcl
https://wiki.tcl-lang.org/page/What+is+Tk

For the morbidly curious about Rcmdr Active Model:

R R Commander

We I i n k h e re 0 Ut to a n Oth e r d OC u m e nt i n File Edit Data Statistics Graphs Models Distribution

Q Data set: syntheticTrial_BrownFatActivation

* Synthetic Trial example of Brown Fat Activation

R Script R Markdown

setwd ("C:/Users/wilkinskj/OneDrive - Nati

* What is effect of days of treatment, standard v. new? e e
* Note that these are completely synthetic data curated for illustration
» Posited ‘trial’: a convenience sample of college students enrolled in Summer

» For sake of participant convenience, each student chose length of time at NIH
* This set length of Assigned Treatment (in days within Metabolic Chamber unit at Clinical Ctr.)
« Some opted for ‘long weekend’ stay while others’ schedules accommodated half a month or so
« At time of discharge, each student is ‘challenged’ (cold exposure): measure brown fat activity

« Key comparison: does an intramural-developed novel agent elicit greater brown fat activation per
specialized time-denominated imaging than ‘standard’ cold exposure re-used per prior trial

» Thankfully, each arm exhibited comparable exposure: ‘DaysOfAssigned Treatment’!

m) ;' YYYYY i
7
950-207%°

In additional materials, you can follow along in seeing arm-based outcome regression NIDDK




O 2 0rolo 0 D0 N or A - N0 E

R R Commander

a - ) . . - ' - . . - File Edit Data Statistics Graphs Models Distribution
R\ Dataset:| | syntheticTrial_BrownFatActivation
« Synthetic Trial example of Brown Fat Activation

setwd ("C:/Users/wilkinskj/OneDrive - Natij

 What is effect of days of treatment, standard v. new? oemsmsrmee -
* Note that these are completely synthetic data curated for illustration
» Posited ‘trial’: a convenience sample of college students enrolled in Summer

* For sake of participant convenience, each student chose length of time at NIH
* This set length of Assigned Treatment (in days within Metabolic Chamber unit at Clinical Ctr.)
« Some opted for ‘long weekend’ stay while others’ schedules accommodated half a month or so
At time of discharge, each student is ‘challenged’ (cold exposure): measure brown fat activity
» Key comparison: does an intramural-developed novel agent elicit greater brown fat activation per
specialized time-denominated imaging than ‘standard’ cold exposure re-used per prior trial

« Thankfully, each arm exhibited comparable exposure: ‘DaysOfAssignedTreatment’!

> numSummary (syntheticTrial BrownFatActivation[, "DaysOnAssignedTreatment”, drop=FALSE],
+ groups=synthetlcTrlal_BrownFatActlvat10n$Ass;gnedT:eacment, statistics=c("mean", "sd", "IQR", "quantiles"),
+ quantiles=c(0,.25,.5,.75,1))

‘ mean sd IQR 0% 25% 50% 75% 100% DaysOnAssignedIreatment:n
® et WW\ Self-administered Cold Exposure 9 3.236694 1.75 4 8.00 8 9.75 19 22
Novel Intramural Agent 9 3.236694 5.50 4 6.25 9 11.75 14 22 Gy 4T

In additional materials, you can follow along in seeing arm-based outcome regression NIDDK =




	R is For All – Part 1: R Commander�Alongside R Swirl, R Commander as ‘Quick Start’: a �code-generating Graphical User Interface to serve as ‘gateway’ to sooner use of R in your Data Analyses�
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